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Name: _____________________________________    Date: ____________________ 

 Exploring the Titanic 
Lessons Using The Geographic Perspective 

LLeessssoonn 

Shortly before 14 April 1912 came to a close, the Titanic passenger ship struck an 
iceberg on its very first voyage across the North Atlantic.  This resulted in the loss two  
hours later of over a thousand of its passengers and crew.  The Titanic represents one 
of the most famous ocean disasters in history.  In this lesson, you will explore the route, 
the sinking, the rescue, and the discovery of the Titanic, examining ocean currents, 
icebergs, map projections, and several mysteries along the way.  You will be using 
Geographic Information Systems (GIS) to accomplish this, conducting an investigation 
of your own using satellite images, tables, charts, and computerized maps.   
 
Read the following text to prepare you for this lesson, and answer the questions that 
follow. 
 
Titanic and her sister ship Olympic were built by the shipping company White Star Line 
to rival Mauretania and Lusitania – ships belonging to the competing Cunard line.  At the 
time Titanic was launched, it was the largest moving object ever built.  The enormous 
ship was 269 meters long (882 feet and 9 inches), and 104 feet high, with a weight of 
46,328 tons.  It was dubbed as “unsinkable” because of its 16 watertight compartments.   
 
Before the 1950s, passenger ships, or “ocean liners” were, in the words of maritime 
historian John Maxtone-Graham, “the only way to cross.”   
 
In the age before the jet airplane, the world had since the mid-19th century witnessed an 
explosion in shipbuilding technology.  One of the main reasons to this was the steam 
engine.  Although skeptical and reluctant to change their age-old profession in the 
beginning, sailors soon began to favor the steam engine instead of sails. The first 
steamship to cross the North Atlantic was the paddle steamer Savannah. In 1819, it 
made the trip from the Savannah River to Liverpool in 27 days. Although its steam 
engine was used for only 85 hours of the voyage, this marked the beginning of a new 
era.  
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At first, these revolutionary vessels’ prime objective was to carry mail between the 
continents.  Hence, the Titanic’s official name was RMS Titanic - Royal Mail Steamer.  
But passengers, up until then referring to sailing vessels as 'Coffin Ships' because they 
seldom meant a safe crossing, soon discovered the improved safety and reliability of the 
new steam ships.  Therefore, a group that so far had been a side income for the 
shipping lines, soon became the most important aspect of the trade--the passenger.  
 
During the rest of the century, ships developed at a rapid pace. Soon, sails disappeared 
altogether, and the far more efficient propeller replaced the paddle wheels.  With the 
number of immigrants to America increasing, the market called for bigger and faster 
ships. Ironically, the once so dominant sailing vessels were now used to ship and store 
coal for the new rulers of the sea.  
 
By the end of the 19th century and the beginning of the 20th, the ocean liner had 
definitely established its place in the world.  Now, they were not only means of 
transportation, but also great symbols of the nations who built them.  With nationalism 
blooming in every corner of Europe and America, each nation wanted to boast with the 
best liners in the world being theirs. This struggle stood often between Great Britain and 
Germany. During this time, many beautiful ships were born, but sadly the circumstances 
leading to their creation would result in the destruction of some of the greatest. World 
War I saw the end of the Britannic, another sister ship of the Titanic, which was launched 
after the Titanic sank.  Britannic was originally named Gigantic.  The Lusitania, another 
passenger ship, was torpedoed off of Ireland during World War I.   
 
After the war, the fleet of the Allies was rebuilt with German war prizes, and the 
transatlantic trade experienced yet another boom in the 1920s. Although the depression 
struck hard on both the shipping lines and the shipbuilders, the 1930s was the decade in 
which ships like the Normandie and Queen Mary and Queen Elizabeth came to life.  And 
other fantastic ships were to be built in the decades to come.  
 
By the end of the 1950's, the competition from airlines became fierce.  During the 
decade, the number of passengers crossing the Atlantic by sea dropped by half, while 
the number of passengers preferring to cross the Atlantic by air quadrupled.   
 

Today, only one of these ships remains in transatlantic service. This is the Queen 
Elizabeth 2, owned by the Cunard Line, but there are plans to build a Queen Mary 2 by 
2003. 

0a.  Name 3 reasons that ocean liners were so important during the period 1850 to 
1950. 
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Now you are ready to begin your GIS-based investigation! 
 
 
Step 1.  Begin Geographic Investigation Using GIS Tools 
 

1a.  Double-click the ArcView icon on your computer's desktop, or go to:    
  Start 
   Programs 
    ESRI 
     ArcView 
      ArcView 3 
 
1b.  If the Welcome to ArcView dialog appears, click Open an Existing Project and click 
OK.  Otherwise, proceed to Step 2. 

 

 

Step 2.  Investigate the Titanic 

2a.  A project file has been created for you.  To open the file, go to the File menu and 
choose Open Project. 
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2b.  Navigate to the directory where your teacher has placed the Titanic data and 
lesson.  (such as c:\teaching\titanic) and choose titanic.apr from the list. 
 

 
  

 
2c. Click OK. 
 

When the project opens, you will see a world map with oceans and countries in a 
canvas, or view, called “Titanic Investigation - Part 1” 

2d. Maximize your ArcView window or stretch your View window so it is bigger.  
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Step 3.   Examine the Origin of the Titanic 
 

The Titanic began its maiden voyage in the United Kingdom, and was destined for the 
United States.  Note that the countries theme is active, or “raised up.”  Use the Find tool  

 to find “United Kingdom”.   Use the same tool to find “United States”.  Then, use the 
label tool  (looks like a price tag) and click in the two countries to label them. 

3a.  What direction did the Titanic sail to attempt to reach the country it was bound for? 

  

3b.  What ocean did the Titanic cross en route to its final destination? 

  

Use the select tool  to select your text of the United Kingdom.  Press the “delete” key 
on your keyboard to delete it. 

Next, you will examine the first part of the Titanic’s route.   

Turn on the theme “cities” by placing a check mark in the box to the left of the theme 
name. 

Use the zoom in tool to click and drag a box on the east side of the North Atlantic,  
around  the British Isles, including England, the northern part of France, and Ireland. 

Make the Ocean Names theme visible by checking the small box next to the theme 
name.  Make the Ocean Names theme active by single-clicking on the theme name so 
that it is “raised up.”  Ocean Names is only a point theme designating where the names 
of the oceans are located.  If the names do not appear with the points when the theme is 
turned on, using the “theme” pull-down menu, select “auto-label.”  In the dialogue box 
allow overlapping labels and check the “scale labels” box.   

Your view should look similar to the following: 
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3c.  Click on the countries theme once to make it active (“raised up”).   Click the label 
button  on each country that comprise the islands that you see in this view.  What two 
countries are these? 

  

 

 

Read the following paragraph: 

A failed 1916 Easter Monday Rebellion in Ireland touched off several years of guerrilla 
warfare that in 1921 resulted in independence from the United Kingdom for the 26 
southern counties.  The 6 northern counties (Ulster) remained part of the United 
Kingdom as Northern Ireland.  In 1948, Ireland withdrew from the British 
Commonwealth.  Ireland joined the European Community in 1973.  Irish governments 
have sought the peaceful unification of Ireland and have cooperated with Britain against 
terrorist groups.  A peace settlement for Northern Ireland, approved in 1998, has not yet 
been implemented.  

3d.  At the time of the Titanic, which 1 of the 2 countries occupying the islands in your 
view did not exist as an independent country? 

  

  

 

View and label the cities by doing the following: 

Make the cities theme visible by checking on the small box to the left of the theme name. 

Make the cities theme active by single-clicking on the theme name so that it is “raised 
up.” 

Using the “Theme” pull-down menu, select “Auto Label.”  In the dialogue box, allow for 
overlapping labels and check the box that says “scale labels.” There should be checks in 
the boxes.  Then click okay.  The cities should now be labeled.   

The Titanic’s home port was registered as Liverpool.  Find it on your map. 

 

3e.  Move the mouse over Liverpool (move mouse over the point, not the label).  Note 
the latitude and longitude coordinates to the upper right of the view.  What is its latitude 
and longitude? 

  

Open the attribute table for the cities theme by selecting the “Open Table” button:      

Use the Find tool to  find Liverpool in the table. 

3f.  What is Liverpool’s population? 
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Clear the selection  and Close the table. 

 

The photograph below shows the launch of the Titanic, from the Belfast shipyard of 
Harland & Wolff on 31 May 1911.   

 

 

3g.  Based on this information, examine your cities theme.  From what country was the 
Titanic launched? 

 

The Titanic completed her trials on 1 April 1912.  The Titanic arrived in Southampton on 
3 April.   

3h.  Based on the information above and by examining your map, in what 2 seas was 
the Titanic most likely to have been tested for ocean voyages?   

  

 

3i.  Through what body of water did the Titanic sail to reach the port where its 
Transatlantic crossing would begin? 

 

Ask your teacher for instructions on where to save this ArcView project and what to 
name it. 

Save your project using the save button .    

What is your project’s name? ___________________ 

Give the path, or directory, name where the project is located on your computer: 
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Now, you are ready to begin exploring the maiden voyage of the Titanic! 

 

Step 4.   Explore the Maiden Voyage of the Titanic 

 

Examine the table below of the first two days of the Titanic’s maiden voyage to New 
York. 

10 April 1912 12 Noon Leaves Southampton dock; narrowly 
escapes collision with American Liner New 
York. 

 6:35 pm Arrives at Cherbourg for passengers. 

 8:10 pm Leaves Cherbourg for Queenstown. 

11 April 1912 11:30 pm Arrives at Queenstown for passengers and 
mail.  One crewman deserts. 

 130 pm Leaves Queenstown for New York, carrying 
1400 passengers and 940 crew. 

 

4a.  Knowing what you know about the independence date of Ireland, and about the 
route, answer the following question: 

How many countries did the Titanic visit in its short lifetime? 

  

4b.  Name the countries that Titanic visited: 

  

  

4c.  Which of the cities visited by the Titanic are not on your map? 

  

 

4d.  Sometimes, cities are renamed.  Queenstown was located at 51.84 degrees north 
latitude and 8.24 degrees West Longitude.  Move your mouse around the map, noting 
the latitude and longitude coordinates to the upper right of the view.  What city is there 
now? 

  

Originally called Cove of Cork, Cóbh (pronounced “Cove”, meaning “A haven”) was 
renamed Queenstown when Queen Victoria visited in 1849. It was renamed back to 
Cóbh in 1922.   
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Read the following paragraphs about the three ports visited by the Titanic, and answer 
the questions that follow. 

 

Cobh 

Cobh is approximately 20km from Cork City, approximately a 20 minute ride by bus, train 
or taxi. Cobh is a pleasant, modern town that was originally a fishing village.  Cobh is 
built on the Southern coast of The Great Island, one of four major islands in Cork 
Harbor.  The three largest Fota, Little Island and Great Island are connected to the 
mainland by bridge. Fota Island contains Fota Wildlife Park, which is home to hundreds 
of rare animals and birds. Fota also contains an 18 hole Golf course. Cobh sports a 9 
hole course and Little Island contains an 18 hole course. Its streets climb the steep slope 
of the hill, which is crowned by the spectacular St. Colmans Cathedral.  

The Cathedral dates back to 1868 and took approx. 51 years to complete, it is of French 
Gothic architecture and at night is fully floodlit and is a splendid sight from the harbor. 
The Great Island is one of four major islands in Cork Harbor.  

Between 1845 and 1851, 1.5 million emigrants left Cobh to build a new life in the United 
States during the wake of the Irish potato famine.  On 1 January 1892, Annie Moore 
from County Cork celebrated her 15th birthday by becoming the first emigrant processed 
through Ellis Island, New York, after landing from a vessel that had sailed from Cobh.  A 
memorial statue has now been erected in her memory on the quayside from where she 
departed. 

The harbor is one of the largest and safest in the world, capable of taking the largest 
vessels afloat.  The port regularly plays host to ocean going liners and cruise ships and 
was the last port of call for the ill-fated Lusitania and the Titanic.  The Lusitania, another 
passenger ship, was sunk off the coast of Kinsale by a German torpedo in 1915, an 
action that was to hasten the United States involvement in World War I.  A memorial to 
the victims of the Lusitania exists in the town center, many of whom are buried in the Old 
Church Cemetery not far away. 

 

Cherbourg 

Cherbourg (pronounced “Sher-bourg”) is a city in northern France, in Manche District, on 
the English Channel, at the mouth of the Divette River.  

It is a seaport, notably for transatlantic traffic, a major naval base, and a fishing and 
manufacturing center.  Its products include ships and marine supplies, electronic and 
communications equipment, and processed food.  A long breakwater protects the port.  

Cherbourg is built on the probable site of the Roman camp of Coriallum.  By the 11th 
century the community was known as Carusbar or Carusburc.  The English sacked it in 
1295, but it withstood several English sieges during the following two centuries.  Projects 
for the fortification and improvement of the harbor were initiated in the 17th century.  In 
1758, Cherbourg was captured by the British, and its port facilities were destroyed.  
They were restored in a long-term project begun in the 1770s and completed in the mid-
1800s.  In 1940, during World War II, the city was occupied by the Germans, and it 
suffered heavy damage while being recaptured by the Allies in 1944.  
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Southampton 

Southampton is the site of the Roman Clausentum and of the Saxon Hamtune or Suth-
Hamtun. Remains of the ancient town walls and reworked Norman structures may be 
seen. The Crusaders under Richard I, Henry V on his expedition to France (1415), and 
the Pilgrims all embarked from Southampton. Until the discovery during the 1500s of a 
new trade route to India, Southampton had a lucrative trade in goods from the East with 
Venice. In the 18th century, it became a fashionable spa. Trade with the United States, 
the construction of modern docks, and the coming of the steamboat, all worked to 
convert the spa back into a commercial port. The London-Southampton railway, finished 
in 1840, and the double tide of the harbor made Southampton an important shipbuilding, 
trade, and tourist port. It was then England's main ocean liner port. Southampton was 
one of Britain's chief military transport stations in both world wars. The city suffered 
considerable damage in World War II, as a result of which there are new dock facilities 
and shopping districts. The city received a grant of county land after the war to 
accommodate its growing industrial population.  In 1951, a major oil tanker terminal and 
refinery were built on the western shore, and North Sea oil became a primary economic 
focus in 1978. There are several major manufactures, including automobiles, aircraft, 
cables, electrical engineering products, and petrochemicals.  Southampton is Britain's 
second largest port.  Among its schools are the Univ. of Southampton and a teacher-
training college. 

4e.  Which city (or cities) was the departing point for the Pilgrims? 

  

4f.  Which city (or cities) was the departing point for over 1 million people seeking to 
escape the Irish famine? 

  

4g.  Which city (or cities) was constructed on sites of ancient Roman villages? 

  

4h.  Which city (or cities) is likely to have a memorial for the Titanic? 

  

4i.  Which city (or cities) is likely to have a memorial for victims of an additional ocean 
liner that sank, as well as one for the Titanic’s victims? 

  

4j.  Which city (or cities) suffered damage during World War II? 

   

4m.  Based on your reading of the above paragraphs, which city do you predict to be the 
largest?   

4n.  Why? 
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With the cities theme active, open the table for the cities theme by selecting the “Open 
Table” button and scroll to the end:    

4o.  Which of the three cities that the Titanic visited is the largest? 

  

4p.  What is its population? 

  

4q.  Do you suspect that this city was the largest of the three in 1912?  Why or why not? 

  

 

4r.  Which city is the smallest? 

  

4s.  What is its population? 

  

Clear any selections you have made    

Save your project .  

 

Now that you know something about the background of the Titanic and where it visited, 
you can re-create its route in the next step. 

 

Step 5.  Creating the Route of the Titanic 

Use the Draw Line tool to create the first part of the route. 

Find the graphics pull down tool (a dot) and pull it down.   
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Click the Draw Line tool  . Click the city where the Titanic began its voyage.  Click 
once on the second city it visited.  Double-click on the third city it visited to end the line. 

In the lower left corner of your screen, you will see a “segment length” in kilometers and 
a “total length” in kilometers.  The segment length is the portion of the journey from the 
second to the third city visited by the Titanic.  The total length is the length of the journey 
from the first to the third city. 

5a.  How far did the Titanic travel from Southampton to Cherbourg (all answers are 
approximate)? 

  

5b.  How far did the Titanic travel from Cherbourg to Cobh (Queenstown)? 

  

5c.  What was the total travel from the first city to the third? 

  

5d.  Do you think the true distance that the Titanic traveled from Cherbourg to Cobh was 
actually longer or shorter than the distance indicated by your GIS results? 

  

5e.  Why? 

 

 

Press the delete key on your keyboard to remove your line. 

5f.  Zoom in on Cobh.   Move the mouse over the city.  Record its latitude and longitude 
below: 

 

Latitude: ___________________ N 

 

Longitude _________________  

 

5g.  Is Cobh at east longitude or west longitude?   Circle your answer. 

 

 East  West 

 

Next, you are ready to draw the route of the ship as began sailing across the Atlantic 
Ocean, from the city of Cobh. 
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First, pull down the View menu and select “Properties.”  Make sure the Distance Units is 
set to “Kilometers.”  Click OK. 

Zoom out to the extent of all themes in the view .  (Turn off cities theme if the points 
get too distracting).   

Zoom back in to the North Atlantic Ocean, drawing a box using the zoom tool   so 
that you can see the United Kingdom on the eastern edge of the view and the east coast 
of the United States on the western edge of the view. 

From the Window menu, select Show Symbol Window. Select the Marker Palette . 
Change the size to 8.  

 

Click the Color Palette button   .  Change the color to red.   Exit the symbol window.  

Pull down the SchoolTools menu: 



Exploring the Titanic Lesson                                                                                                        Page 14 of 78 
 

 

 

In the dialog boxes that follow, type in the latitude and longitude values that you wrote 
above for Cobh.  Be sure to use negative numbers for west longitude. 

 

 

You will see the red point appear at correct point in the voyage.  

To enter the remaining latitude and longitude points, add all remaining coordinates from 
the table below (points 2 through 14). For each point, you must first select the “add lat 
long point” from the SchoolTools menu and then enter the coordinates in the table.   The 
14th point represents the last recorded position of the ship. 

Point Latitude Longitude

1 51.83 -8.20
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2 51.63 -8.21

3 51.50 -8.36

4 51.33 -10.00

5 50.925 -15.00

6 50.275 -20.00

7 49.325 -25.00

8 48.25 -30.00

9 46.80 -35.00

10 45.05 -40.00

11 42.95 -45.00

12 42.00 -47.00

13 41.775 -50.00

14 41.76 -50.23

 

After entering the first few points, your view should look similar to that below: 
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Your view should look similar to that below: 

 

Save your project using the save button .  

5h.  Record the project's name: 

  

5i.  Record the folder where you have been saving the project: 

  

Now you will use the coordinates you have mapped to draw the route of the Titanic’s 
Transatlantic voyage:   

From the View pulldown menu, select New Theme. For Feature type, select Line. Click 
OK. 

Ask your teacher where you should save your new theme. Navigate to the location your 
teacher directed you to and name the new theme ABCtitanic.shp, where ABC are your 
initials. Click OK. 

The new theme is now added to your table of contents.  You may need to scroll up to 
see it.  It has a dotted line around the theme’s checkbox. This indicates that the theme is 
in “Edit” mode and can be created and modified. Because ArcView randomly selects a 
color for a new theme, you need to change it.  

 

Double-click the new ABCtitanic theme to edit its Legend.  

Double-click the small rectangle to bring up the Symbol Window.  
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Click the Color Palette button  . Click an orange color and make the line symbol  
a 2 point thickness and choose the first arrow symbol.   

 

Click Apply and close the Legend Editor and the Color Palette window.   

 

Now you will use the Draw Line tool and create the route by "connecting the dots" of the 
latitude and longitude points you plotted earlier. 

First zoom in to the first four points, near Cobh.  Click the Draw Line tool  .  Click 
each red dot to create the route. When you get to the fourth point, right click and hold the 
mouse so that you can select “zoom out.”  Keep zooming out until you see more points 
along the route.  Complete the line.  When you reach the final point, double click to end 
the line.   

 

If you double click before the line has ended, press the “delete” key on your keyboard 
and start over.  Your route should be comprised of only 1 line. 

Click the Zoom In tool .  Zoom in on selected points along the route. Check to see if 
your line goes precisely through each dot. 

 

If you find points on the line that need adjusting, click the Vertex Edit tool . The 
vertices are the points you added.  Click the line where it needs modification. Small 
boxes called vertices are visible.  

Click a vertex and drag it to its correct point on the map. Continue this process until the 
entire line is in the correct place.   You can add a vertex if you missed a point by clicking 
on the line where no vertex exists.  Then you can adjust its location in the same way as 
above. 

 

When you are satisfied with your line, perform the following 2 steps: 

 

(1)  Click on the pointer tool .  Click on your line.  Observe the total length of the line 
to the lower left of the view. 

 

5j.  What is the length of the voyage from Cobh to the sinking?    

____________________ kilometers 
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(2)  Select Stop Editing from the Theme pull-down menu. When asked if you want to 
save your edits, click Yes. 

 

Click the Clear Selected Feature button . You can now see the red line that 
represents the route of the Titanic. 

 

From the Theme menu, select Properties. Rename the theme Titanic Route. 

5k.  Write two observations that you notice about the route of the Titanic. 

 

 

 

Use the measure tool  to determine how far the Titanic was from Cobh.  Click once 
on the westernmost point along the route, and continue clicking on points along the 
route.  You can click and hold the right mouse button to zoom in or out if you need to 
along the route.  Double click on Cobh when finished to end the line.   

Read the length to the lower left of the view.  You may have a segment length and a 
second length number.  The second number represents the total length of the line, which 
is the one you want. 

5l.  How far was the Titanic from Cobh?  ______________  kilometers 

 

Repeat this procedure to answer the following question: 

 

5m.  How far was the Titanic from New York?  ______________ kilometers 

 

5n.  Based on your answers above, what percentage of the Atlantic had the Titanic 
crossed when it sank?  Show your work. 

 

 

 

5o.  Was the Titanic over halfway across the ocean when it sank? 

  

5p.  For the final step, you will make a printed map of your investigation in a layout.   
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First, zoom in on the entire route of the Titanic using the zoom   tools and pan 
 tools.  Go to the View pull  down menu and select “Layout.”  Make a landscape 

layout of your route.  Include your name and an appropriate title by using the text tool to 
enter it on the layout  .  Print the layout on a printer. 

Save your project . 

You are now ready to learn about map projections and their affect on measurement. 

 

Step 6.   Exploring Map Projections and the Titanic 

In this section, you will use the route of the Titanic to learn about map projections and 
how they can change distances, shapes, and areas. 

Read the following and answer the questions afterward.   

The Earth is a 3-dimensional object.   Specifically, it is an oblate spheroid, close to being 
a true sphere, but the rotation of the Earth has caused it to “flatten” slightly at the poles.  
Because the earth is a 3-dimensional object, the most accurate way to present the Earth 
is a 3-dimensional globe.  However, problems exist with using the globe to represent the 
Earth.  First, even the largest globe has a small scale and shows very little detail.  In 
addition, a globe is difficult to transport.  Therefore, the Earth is more often represented 
as a 2-dimensional object, or flat map.   

Transforming a 3-dimensional object to a 2-dimensional map requires changing the way 
that things on the 3-dimensional surface will be represented.  For example, if you took 
the skin off the orange and tried to place it flat on your desk, the skin would warp.  It 
would bubble out in some places and in others, tear.  A 3-dimensional object does not fit 
into a 2-dimensional plane.  The same problem occurs when trying to represent the 
Earth as a flat map.  Whenever the Earth is projected onto a flat surface, or map, some 
distortion, or misrepresentation, of the Earth takes place.    The same is true when that 
map is generated and viewed on a computer with a GIS. 

Map projections are attempts to portray the surface of the earth or a portion of the earth 
on a flat surface.  All map projections cause distortion of one or more of the following 
properties:  

1)  Conformality 

2)  Distance 

3)  Direction  

4)  Scale 

5)  Area 

No map projection is inherently “better” than another; it is a matter of determining which 
property is the most important for your use, and choose the projection that distorts that 
property the least. 
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Some distortions of conformality, distance, direction, scale, and area always result from 
this process. Some projections minimize distortions in some of these properties at the 
expense of maximizing errors in others. Some projections are attempts to only 
moderately distort all of these properties: 

Conformality  

When the scale of a map at any point on the map is the same in any direction, the 
projection is conformal.  Meridians (lines of longitude) and parallels (lines of latitude) 
intersect at right angles. Shape is preserved locally on conformal maps.  

Distance  

A map is equidistant when it accurately portrays distances from the center of the 
projection to any other place on the map.  

Direction  

A map preserves direction when azimuths (angles from a point on a line to another 
point) are portrayed correctly in all directions.  

Scale  

Scale is the relationship between a distance portrayed on a map and the same distance 
on the Earth.  

Area  

When a map portrays areas over the entire map so that all mapped areas have the 
same proportional relationship to the areas on the Earth that they represent, the map is 
an equal-area map.  

 

6a.  Using the information above, in your own words, answer this question:   What is a 
map projection? 

 

 

 

6b.  List the 5 things that may be distorted in a map projection: 

 

 

 

Your Titanic map is in the “geographic” projection, which is really not a projection at all, 
just a straight representation of latitude and longitude.   

Change the view to “Investigating the Titanic Part 2” by pulling the Window menu down.  
To examine projections, you will change the view into different map projections. 
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The first projection you will use is the Mercator projection, introduced in 1569 by 
Gerhardus Mercator.  The Mercator projection has straight meridians and parallels that 
intersect at right angles. Scale is true at the equator or at two standard parallels 
equidistant from the equator. The projection is often used for marine navigation because 
all straight lines on the map are lines of constant azimuth (direction).   

Zoom in on the North Atlantic so you can see all of North America and Europe.  

Go to the View pull down menu.  Select “Change Map Projection” and change the 
projection to Mercator. 

6c.  What happened to the shape of the land masses in the Mercator projection as 
opposed to the Geographic projection you were using earlier?   Change back to the 
Geographic projection if you need to in order to compare the two. 

 

 

 

6d.  What happened to the shape of the Titanic’s route in the Mercator projection as 
compared to the geographic projection? 

 

 

 

As you did above, use the measure tool  to determine how far the Titanic was from 
Cobh.  Single click on each point in the route, and double click on Cobh to finish.  The 
distance is given to the lower left of the view. 

 

6e.  How far was the Titanic from Cobh when it sank? 

 ___________kilometers 

Repeat this procedure to answer the following question: 

6f.  How far was the Titanic from New York when it sank?  

____________kilometers 

6g.  How does this compare to your answer when you were using the geographic 
projection? 

 

 

Go to the View pull down menu.  Select “Change Map Projection” and change the 
projection to Mollweide.  The Mollweide Projection, presented by Mollweide in 1805, is a 
quasi-cylindrical, equal-area projection.   
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6h.  What do you notice about the Central Meridian (0 degrees Longitude) in the 
Mollweide Projection versus the other lines? 

 

 

6i.  What do you notice about the lines of latitude? 

 

 

As you did above, use the measure tool  to determine how far the Titanic was from 
Cobh when it sank.   

 

6j.  How far was the Titanic from Cobh?  _____________  kilometers 

6k.  How does this distance compare to your previous observations? 

 

 

Go to the View pull down menu.  Select “Change Map Projection” and change the 
projection to Robinson.  The Robinson projection is based on tables of coordinates, not 
mathematical formulas. The projection distorts shape, area, scale, and distance in an 
attempt to balance the errors of projection properties.  

As you did above, use the measure tool  to determine how far the Titanic was from 
Cobh when it sank (Turn on cities theme if it had been turned off previously).  Click once 
on the westernmost point along the route, and continue clicking on another on Cobh.   

 

6l.  How far was the Titanic from Cobh?  _______________  kilometers 

6m.  How does this distance compare to your previous observations? 

 

 

Next, change to the Sinusoidal Projection.  Sinusoidal is an equal-area projection with 
straight parallels at right angles to a central meridian. Other meridians are sinusoidal 
curves. Scale is true only on the central meridian and the parallels.  It is often used in 
countries with a larger north-south than east-west extent.  

6n.  Make two observations about shapes and the Titanic’s route using this projection. 

 

Use the measure tool  to determine how far the Titanic was from Cobh when it sank.   
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6o.  How far was the Titanic from Cobh?  _____________  kilometers 

 

The last projection you will use is the Orthographic projection, sometimes referred to as 
“The World From Space.”  Orthographic projections are used for perspective views of 
hemispheres.  Area and shape are distorted.  Distances are true along the equator and 
other parallels.  

Go to the View pull down menu.  Select “Change Map Projection” and change the 
projection to Orthographic. 

Use the Change Center tool   to change the map center.  Use 40 degrees latitude 
and -40 degrees longitude.  You may have to pan  the map slightly to restore the 
correct colors and fill. 

6p.  Make two observations about the shapes of land masses and the route of the 
Titanic in the Orthographic projection. 

 

 

The straight line of the route of the Titanic on this projection is a Great Circle route! 

Use the measure tool  to determine how far the Titanic was from Cobh when it sank. 

6q.  How far was the Titanic from Cobh?  _______________  kilometers 

 

6r.  In what projection was the measured distance from where the Titanic to Cobh sank 
the greatest? 

 

6s.  In what projection was the measured distance from where the Titanic sank to Cobh 
the least? 

 

6t.  What was the difference between the maximum and minimum distances you 
measured? 

 

6u.  In your opinion, what projection is best for showing the Titanic’s route and the land 
masses nearby? 

 

 

6v.  In your opinion, does map projection make a big difference in measurement of 
distance?  Why or why not? 
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Go to the View pull down menu.  Select “Change Map Projection” and change the 
projection back to Geographic. 

Save your project . 

In the next step, you will examine ocean currents to understand the influence that they 
had on the Titanic’s demise. 

 

Step 7.   Examining Ocean Currents 

In this section, you will examine the effect that ocean currents had on the Titanic 
disaster. 

Read the following information about ocean currents to prepare you for the questions 
that follow. 

An ocean current is a horizontal movement of seawater at the ocean's surface. Ocean 
currents are driven by the circulation of wind above surface waters. Frictional stress at 
the interface between the ocean and the wind causes the water to move in the direction 
of the wind. Large ocean currents are a response of the atmosphere and ocean to the 
flow of energy from the tropics to polar regions. In some cases, currents are transient 
features and affect only a small area. Other ocean currents are essentially permanent 
and extend over large horizontal distances. 

On a global scale, large ocean currents are constrained by the continental masses found 
bordering the three oceanic basins. Continental borders cause these currents to develop 
an almost closed circular pattern called a gyre. Each ocean basin has a large gyre 
located at approximately 30 degrees North and South latitude in the subtropical regions. 
The currents in these gyres are driven by the atmospheric flow produced by the 
subtropical high pressure systems. Smaller gyres occur in the North Atlantic and Pacific 
Oceans centered at 50 degrees North. Currents in these systems are propelled by the 
circulation produced by polar low pressure centers. In the Southern Hemisphere, these 
gyre systems do not develop because of the lack of constraining land masses. 

A typical gyre displays four types of joined currents: two east-west aligned currents 
found respectively at the top and bottom ends of the gyre; and two boundary currents 
oriented north-south and flowing parallel to the continental margins. Direction of flow 
within these currents is determined by the direction of the macro-scale wind circulation. 
Boundary currents play a role in redistributing global heat across latitudes. 

 

7a.  What causes ocean currents? 

  

 

First, you’ll need to copy the Titanic route that you digitized earlier to a different view.   

http://www.geog.ouc.bc.ca/physgeog/physgeoglos/o.html
http://www.geog.ouc.bc.ca/physgeog/physgeoglos/g.html
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Make the Titanic Route theme active (“raised up”) in the View entitled “Titanic 
Investigation - Part 1.” 

From the Edit pull down menu, select Copy Themes. 

Go to the Window pull down menu and select the View entitled “Titanic Investigations 
Part 2.” 

From the Edit pull down menu, select Paste.  Your Titanic Route theme should appear.   
Maximize or resize this window as necessary to help you in your work. 

In this view, make the “Ocean Currents” theme visible and make it the active theme, 
“raised up.” 

You should see the names of the ocean currents and the currents themselves. 

If the ocean currents are not already named, Go to the Theme pull down menu and 
select Auto Label.  Allow Overlapping Labels and scale labels. 

Open the attribute table   for the ocean currents. 

7b.  How many ocean currents exist on this map? 

 

Examine the “length” field.  These are the lengths of the currents in degrees of latitude 
and longitude.  Click on the title of the “length” field to make it active. 

Sort the table by clicking on the “sort descending” button . 

7c.  Which is the longest current? 

 

 

7d.  How long is the Gulf Stream? 

 

 

7e.  How long is the Labrador Current? 

 

 

Considering the above text and your map, answer the following questions. 

7f.  Name the currents that make up the North Atlantic gyre: 
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7g.  Do ships sailing from east to west across the North Atlantic move with the current or 
against  the current?   

 

 

7h.  How does this affect their speed? 

 

7i.  Would you consider the Gulf Stream a warm water current or a cold water current?  
Explain your answer. 

 

7j.  Based on your answer above, what influence do you think the Gulf Stream has on 
the climate of Europe? 

 

 

7k.  Would you consider the Labrador Current a warm water current or a cold water 
current?  Explain your answer. 

 

Save your project . 

Now that you know about ocean currents, you can use this information to examine 
icebergs, in the next step. 

 

 

 

Step 8.   Exploring Icebergs 

You will now have the opportunity to apply what you have been learning about ocean 
currents to icebergs and the Titanic disaster.   Use the information in your Ocean 
Currents theme in the View “Titanic Investigation—Part 2” to help you answer the 
following questions. 

8a.  Which two currents in the North Atlantic cause icebergs to drift into shipping lanes in 
the North Atlantic? 

 

8b.  If most icebergs in the North Atlantic come from Greenland, which side of the North 
Atlantic (east or west) are icebergs more common?  Explain your answer. 
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The Greenland icecap contains 1/8 of the total global ice mass. The total ice mass on 
earth is 30 million cubic kilometers.   

8c.  How many cubic kilometers of ice does Greenland contain?  Show your work. 

 

Read the following text to help you answer the questions. 

Used by permission.  http://users.skynet.be/deneyer/index.html  from Yves Beaufays. 

 

 
East Greenland icebergs are small and few in number.  The western shore of 
Greenland, by contrast, contains the fastest-flowing glaciers on the Earth and produces 
the most icebergs.  The Quarayaq Glacier flows at a velocity between 20 and 24 meters 
per day, greater than the velocity of most Alpine (mountain) glaciers.  Jakobshavn 
Glacier produces 10 percent of all the Greenland icebergs (approximately 1,350 
annually) and flows at about 20 meters per day. The icebergs accumulate in a fjord and 
periodically spill from this fjord in groups accompanied by noise that can be heard for 
several kilometers. This greatest iceberg-producing glacier measures only 7 kilometers 
along its front and is 90 meters above sea level. In contrast to the rapidly moving 
glaciers, the very wide glaciers that move slowly produce only very small icebergs.  
Some glaciers, such as the Frederikshåb, Greenland, with a 33-kilometer front, have 
rates of flow equal to the rate of melting, and thus produce no icebergs. The annual yield 
of icebergs in the Arctic is, at the most, 15,000, with only 5,000 or so of sufficient size to 
reach the open ocean intact. 

The largest glacier in the Northern Hemisphere is the Petterman Glacier, at 81 degrees 
north latitude and 62 degrees west longitude.  Although it is only a few meters above 
seawater, its ice foot extends as far as 40 kilometers out to sea, and it pushes a path 
through old piled-up sea ice. These long fingers of glacier ice, under severe climatic 
conditions, break off once every 10 to 20 years. Another glacier of importance is the 
Jungersen Glacier in northern Greenland. This glacier and the Petterman Glacier 

http://users.skynet.be/deneyer/index.html
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produce tabular icebergs, known in the Arctic as "ice islands."  They are similar in shape 
and mode of formation to the large tabular icebergs of the Antarctic but are much 
smaller.  

The icebergs that reach the North Atlantic Ocean from northern Greenland, Siberia, and 
the Northwest Territories constitute less than 10 percent of the total icebergs produced 
in the Northern Hemisphere. They do not affect the sea routes and, other than their 
formation of ice islands, have no importance to humans. Most icebergs originating from 
western Greenland are of great importance.  The annual production is about 7,500 
bergs.  The Arctic total is 10,000 to 15,000; the Labrador Current carries 800 to 1,000 
into the open ocean annually. 

8d.  From which side of Greenland—west or east—do most icebergs originate? 

 

8e.  Therefore, which current carries more icebergs, the Labrador or the East Greenland 
Current? 

 

8f.  Which current was more likely to produce the iceberg that the Titanic struck? 

 

8g.  Which type of glaciers produces the most icebergs—the wide or the narrow type? 

 

Using the measure tool  , answer the following questions: 

8h.  What is the minimum distance the iceberg traveled from Greenland down the 
Labrador Current to reach the Titanic?   

 

Make the theme Greenland Glaciers visible and active.  Pull down the Theme menu for 
Greenland Glaciers, and select Auto Label, using “Name” as the naming field for this 
theme. 

8i.  Based on the paragraphs that you read earlier, what is the most likely distance the 
iceberg traveled?  Why? 

 

 

Of the 10,000 to 15,000 icebergs calved from glaciers annually in the Arctic, only 375 on 
the average pass Newfoundland, or latitude 48 degrees north, into the North Atlantic 
Ocean.   

8j.  What percentage of icebergs pass Newfoundland each year?  Show your work. 

 

 



Exploring the Titanic Lesson                                                                                                        Page 29 of 78 
 

8k.  Was the iceberg that the Titanic struck to the south of Newfoundland? 

 

8l.  What does this tell you about the likelihood of such a collision occurring in any given 
year? 

 

Examine the following graph: 
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8m.  During what year(s) was the most icebergs reported south of 48 degrees latitude? 

 

 

8n.  During what 6 years was the fewest icebergs reported south of 48 degrees latitude? 

 

 

8o.  Examine your view.  Was the Titanic south of 48 degrees latitude when it struck the 
iceberg? 

 

8p.  How many icebergs were reported south of 48 degrees north latitude during the 
year the Titanic sailed? 

 

8q.  During how many years were over 1000 icebergs sighted south of 48 degrees? 

 

 

8r.  Was 1912 included in this list? 

 

 

8s.  Make 1 observation on the severity of the icebergs during the year that the Titanic 
sailed and 1 general observation about all the years shown on the graph. 

 

 

Read the following and answer the questions that follow. 

Once an Arctic iceberg breaks away or “calves” from the ice cap and drifts out to the 
open sea, it may spend three months to two years in Baffin Bay.  Using the find tool, find 
Baffin Bay in your view.  Make sure the ocean names are on.  During this time, the 
iceberg undergoes some disintegration through melting and calving of small chunks of 
ice from its perimeter.  

 

This results in a decrease in mass of about 90 percent by the time it reaches the coast of 
Newfoundland and the Grand Banks in the North Atlantic. When the iceberg enters the 
region of the Grand Banks, where the warm waters of the Gulf Stream meet the colder 
waters of the Labrador Current, it has only a few days of life remaining.  
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8t.  When could the iceberg that the Titanic hit have been born (calved off a glacier)? 

Anytime from  ______________________  to  

_______________. 

 

8u.  How long after the Titanic struck the iceberg did the iceberg live? 

 

8v.  The Titanic sunk within 3 hours of striking the iceberg.  Based on the reading, which, 
in all probability, lasted longer after the collision—the iceberg or the Titanic? 

 

 

 

This is supposedly the iceberg with which the Titanic collided. 

This print was in possession of Captain De Carteret, the Captain of the Cable ship 
MINIA, reportedly stated that this was the only iceberg near the scene of the collision. 
The MINIA was one of the first ships to reach the scene following the disaster. It was 
dispatched after the Western Union Cable ship MACKAY BENNET by White Star Lines 
to recover debris from the Titanic. During this operation, the MINIA found debris and 
bodies floating in the vicinity of the above iceberg. Therefore, it is assumed that this is 
the iceberg that the Titanic struck. Captain De Carteret gave the print to Captain A. L. 
Gamble, Commanding Officer of the USCGC SENECA. 

Below  is another photograph of supposedly the iceberg with which the Titanic collided. 

This iceberg was photographed by the chief steward of the liner Prinze Adelbert on the 
morning of 15 April 1912, just a few miles south of where the Titanic went down. The 
steward hadn't yet heard about the Titanic. What caught his attention was the smear of 
red paint along the base of the berg, indication that it had collided with a ship sometime 
in the previous twelve hours. (Photo and information was from Unsinkable—The Full 
Story of RMS Titanic, by Daniel Allen Butler, Stackpole Books, 1998. 
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Save your project . 

Next, you can deepen your analysis of the Titanic considering more information. 

 

Step 9.  Further Investigation of Ocean Currents, Icebergs, and the Grand Banks 

Turn on the themes:  Iceberg Extent and Iceberg Drift. 

Iceberg Extent indicates the main areas of ice on the North Atlantic.   

Iceberg Drift indicates the known examples of extreme iceberg drift from 1890 to 1966, 
as reported by the US Naval Ocean Office in 1968. 

Make the Iceberg Drift theme active and open its attribute table  . 

Note the number of icebergs, given in the area above the view window. 

9a.  How many icebergs strayed outside the main area of icebergs during the 76 year 
reporting period? 

 

Close the attribute table. 

 

9b.  In which side of the Atlantic Ocean were most stray icebergs reported? 

 

9c.  What was the southernmost latitude that an iceberg ever was reported?  You may 
need to turn off the ocean currents to see more clearly. 

 

 

Move your ABCTitanic theme, the route of the ship, above the two iceberg themes and 
make sure it is turned on. 
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9d.  Did the Titanic enter the main area of icebergs? 

e.  Use the measure tool to find out how many kilometers the Titanic was sailing inside 
the main area of icebergs: 

 

 cross section of an iceberg. 

 

9

_____________ kilometers

Examine the image below of a

 

9f.  What does the image tell you about one of the hazards of icebergs? 

urn off all themes except the iceberg themes. 

xtent of ice in Greenland versus other places around 
the globe? 

he image gives a good impression of the ocean floor, as well.  Notice the higher, flat 
areas of ocean floor near the continents called Continental Shelves. 

 

 

T

Turn on the Earth Image Theme.   

9g.  What do you notice about the e

 

 

T
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9h.  At what latitude and longitude did the Titanic leave the continental shelf of Europe? 

urn on the Canada theme.  Label the provinces 

 

T  until you have located 
Newfoundland and Labrador.  

helf to the southeast of Newfoundland.  This is called the 
“Grand Banks.”   

i.  Use the measure tool.  How close did the Titanic sail to the Grand Banks? 

ead the following to help you answer the questions that follow. 

e banks, while the Gulf 
Stream sweeps along the eastern edge, sometimes crossing the southern part. The 

ar the Grand Banks? 

k.  Recalling what you wrote earlier for the temperature of the Gulf Stream and the 
Labrador Current, why does this phenomenon occur at the Grand Banks? 

l.  Why would this have made the problem of the icebergs for shipping worse? 

Notice the area of Continental S

 

9

 

 

R

At the Grand Banks, the Labrador Current flows over most of th

Grand Banks are noted for the persistent dense fog, formed as warm air passes over the 
cold water that engulfs the area. The mingling of the two currents along with the 
shallowness of the water forms a favorable environment for plankton and other small sea 
life upon which cod, haddock, halibut, and other fish feed.  Lobsters are also found 
there.  Fog, icebergs, and the nearby transatlantic shipping lanes make fishing 
hazardous. The Grand Banks were probably the world's most important international 
fishing ground until 1977, when Canada extended its offshore jurisdiction to include most 
of the area. Many of the commercial species, however, were overfished and depleted by 
the early 1990s. Oil drilling began on the banks in the late 1970s, but was slowed after 
the loss of the Ocean Ranger rig on Feb. 15, 1982. 

9j.  What is the major hazard to navigation at and ne

 

 

9

 

 

9
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9m.  Examining the Earth Image together with the extent and drift of icebergs, observe at 
least one relationship between the two themes and write your observation below: 

ave your project

 

 

 

S  . 

w about icebergs, ocean currents, you are now ready to analyze 
another factor in the Titanic’s building and route, the Blue Riband. 

tep 10.   Investigating the Blue Riband 

ow to answer the questions that follow.   

 to 
make the crossing of the Atlantic Ocean towards London.  In itself, this was not so 

asted schooner.  
However, it introduced two features that would become the characteristics of the 

Now that you kno

 

S

Read the following to help you understand h

On 17 August 1833, a ship named Royal William left the Pictou, Nova Scotia harbor

remarkable, since ships had been crossing the Atlantic for centuries.  The remarkable 
fact was that the Royal William would make the crossing powered for the majority of the 
time by steam.  There had been other “steamships” that had crossed the Atlantic, but on 
those ships the steam engines were just an aid and not the principal propulsion (such as 
the Savannah).  On the Royal William, the sails were only needed when the engines had 
to be cleaned from salt.  Although the Royal William was far from the luxury Liners in the 
1920s and 30s, it has marked the beginning of the steam era at sea.   

At first sight, the Royal William looked a lot like a traditional three-m

transatlantic steamships in the following decades—a funnel and two large sidewheels, 
each of them more than 5 meters in diameter (see picture). 

 

 

With her engines, the Royal William could produce 200 hp, with a top speed of 8 knots 
(approximately 15 kilometers per hour).  The entire voyage took 25 days, which 
corresponded with an average speed of 4.5 knots. 
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As of that moment, humankind was no longer dependent on nature to cross the Atlantic 
Ocean.  It was the go-ahead signal for a contest to have the fastest transatlantic ship—a 
battle that has lasted for 160 years—The battle for the “Blue Riband.”  The term “Blue 
Riband of the Atlantic” came into use in the 1860s.  This was the British term; the 
Americans called it “Blue Ribbon.”  The transatlantic shipping companies introduced it, 
because having the fastest merchant ship of the period in one’s fleet meant gigantic 
publicity for the particular ship and the shipping company.  To make the honor of being 
the fastest ship on the Atlantic somewhat tangible, the honorable ship had the right to fly 
a long blue pennant (the “blue riband”) in its top mast.  But, although the term “Blue 
Riband” wasn't introduced until the 1860s, its essence dates back to the 1830s, when 
ships as Sirius and Great Western fought over the honor of being the fastest 
transatlantic Liner.    

Examine the table below of the Blue Riband record holders crossing the Atlantic going 
west: 

Year Ship Shipping Line Average Speed 

1838 Sirius British and American Steam 
Navigation Company 

8.03 knots 

1838-1841 Great Western Great Western Steamship 
Company 

9.52 knots 

1841-1843 Colombia Cunard Line 9.78 knots 

1843-1845 Great Western Great Western Steamship 
Company 

10.03 knots 

1845-1848 Cambria Cunard Line 10.71 knots 

1848 America Cunard Line 11.71 knots 

1848-1850 Europa Cunard Line 11.79 knots 

1850 Asia Cunard Line 12.25 knots 

1850-1851 Pacific Collins Line 12.46 knots 

1851-1856 Baltic Collins Line 13.04 knots 

1856-1863 Persia Cunard Line 13.11 knots 

1863-1872 Scotia Cunard Line 14.46 knots 

1872 Adriatic White Star Line 14.53 knots 

1872-1875 Germanic White Star Line 14.65 knots 

1875-1876 City of Berlin Inman Line 15.21 knots 

1876-1877 Britannic White Star Line 15.43 knots 

1877-1882 Germanic White Star Line 15.76 knots 
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1882-1884 Alaska Guion Line 17.05 knots 

1884-1885 Oregon Guion Line 18.56 knots 

1885-1887 Etruria Cunard Line 18.73 knots 

1887-1888 Umbria Cunard Line 19.22 knots 

1888-1889 Etruria Cunard Line 19.56 knots 

1889-1891 City of Paris Inman & International Line 20.01 knots 

1891 Majestic White Star Line 20.10 knots 

1891-1892 Teutonic White Star Line 20.35 knots 

1893-1894 Campania Cunard Line 21.44 knots 

1894-1898 Lucania Cunard Line 21.81 knots 

1898-1900 Kaiser Wilhelm 
der Grosse 

Norddeutscher Lloyd 22.29 knots 

1900-1902  Deutschland Hamburg Amerika Line 23.06 knots 

1902-1903 Kronprinz 
Wilhelm 

Norddeutscher Lloyd 23.09 knots 

1903-1907 Deutschland Hamburg Amerika Line 23.15 knots 

1907-1909 Lusitania Cunard Line 25.65 knots 

1909-1929 Mauretania Cunard Line 26.06 knots 

1929-1930 Bremen Norddeutscher Lloyd 27.91 knots 

1930-1933 Europa Norddeutscher Lloyd 27.92 knots 

1933-1935  Rex Italia Line 28.92 knots 

1935-1936 Normandie Compagnie Générale 
Transatlantique 

29.98 knots 

1936-1937 Queen Mary Cunard White Star Line 30.14 knots 

1937-1938 Normandie Compagnie Générale 
Transatlantique 

30.58 knots 

1938-1952 Queen Mary Cunard White Star Line 30.99 knots 

1952- United States United States Lines 34.51 knots 

    

The Eastbound record was broken by these three vessels in recent years: 
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24 Jun 1990 Hoverspeed Great Britain Hoverspeed 36.97 knots 

10 Jun 1998 Catalonia Buquebus 38.85 knots 

20 Jul 1998 Cat-Link V Scandlines 41.28 knots 

 

The Cat-Link V was able to cross the Atlantic Ocean in 2 days, 20 hours, and 9 minutes. 
These vessels are really powerboats, not ocean liners, as they are all less than 100 
meters long. 

10a.  Which ocean liner currently holds the record for crossing the Atlantic? 

 

10b.  How long has it held this record? 

 

10c.  Which vessel currently holds the record for crossing the Atlantic? 

 

 

10d.  At the time of the sailing of the Titanic, which ship held the record for crossing the 
Atlantic? 

 

The record meant that the ship at that time could cross the Atlantic in 4 days, 10 hours, 
and 51 minutes. 

10e.  What was the average speed of the ship holding the record during Titanic’s time? 

 

 

10f.  Use the Measure Tool   to measure how far the Titanic had traveled, from Cobh 
to its sinking. 

_______________ kilometers. 

 

10g.  Use the Measure Tool   to measure how far the Titanic had left to travel to 
reach New York. 

 

_______________ kilometers. 

Recall that near the beginning of this lesson you learned that the Titanic left Cobh on 11 
April 1912 at 130pm ship’s time. 
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The Titanic struck the iceberg at 1140pm ship’s time on 14 April 1912. 

10h.  Approximately how many hours had it been sailing?  Fill in the blanks below. 

_______  hours on 11 April. 

_______  hours on 12 April. 

_______  hours on 13 April. 

_______  hours on 14 April. 

 

_______  Total Hours of Travel. 

 

 

 

10i.  Use this number of total hours, and your estimate above of the total distance the 
Titanic had traveled to compute its average speed: 

 

____________ distance in kilometers the Titanic had traveled 

 

______________ hours  

 

___________ average speed.  This is in kilometers per hour. 

 

10j.  To obtain the speed in miles per hour, multiply your answer by 0.6214 and enter the 
result below: 

 __________ miles per hour. 

 

Rather than miles per hour, ships often use the unit called knots. 

10k.  To obtain the speed in knots, divide your miles per hour answer by 1.15, and enter 
the result below: 

 

___________ knots was the average speed of the Titanic. 

 

Compare this speed to the speed of the ship you identified above that held the record at 
the time of the Titanic’s sailing. 
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10l.  It is important to note that the Titanic was primarily built for luxury, rather than for 
speed.  Even so, if the Titanic had not sunk, and if it had continued at its average rate of 
speed, would it have captured the Blue Riband? 

 

 

10m.  The Titanic left Queenstown on April 11, 1912 at 1:30 pm.  Using the measuring 
tool, compute the distance between Cobh (Queenstown) and New York City in 
kilometers?   

 

 

10n.  Given the average speed you calculated above in kilometers per hour in question 
10i and the distance in 10m, when would the Titanic have arrived in NYC? 

 

 

 

Save your project . 

Next you will plot your own proposed route for the ship using your knowledge about 
icebergs, ocean currents and the Titanic’s distance and speed. 

 

Step 11.   Planning An Alternative Route for The Titanic 

You know the actual Titanic’s route as well as the extent of icebergs.  Use this 
information to propose and create your own route for the Titanic that, in your judgment, 
would have resulted in a successful voyage. 

Make the following 5 themes visible (and make all other themes invisible): 

Ice Extent 

Ice Drift 

Countries 

Titanic Route 

Oceans 

 

Using the Titanic Investigations—Part 2 View, from the View pull down menu, select 
New Theme.  
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For Feature type, select Line.  Click OK. 

Ask your teacher where you should save your new theme that will represent your 
proposed Titanic route.  Navigate to the folder your teacher directed you to and name 
the new theme abcnewroute.shp, where ABC are your initials.  Click OK. 

The new theme is now added to your table of contents.  You may need to scroll up to 
see it.  It has a dotted line around the theme’s checkbox. This indicates that the theme is 
in “Edit” mode and can be created and modified. Because ArcView randomly selects a 
color for a new theme, you need to change it.  

Change the name of the Theme in the Theme pulldown menu under Properties, from 
abcroute, to “Proposed Route” 

Double-click your new abcnewroute (Proposed Route) theme to edit its Legend.  

 

Double-click the small rectangle to bring up the Symbol Window.  

 

Click the Color Palette button  . Click a blue color.  Click Apply and close the Legend 
Editor and the Color Palette window.   

 

Now you will use the Draw Line tool to create your own route for the Titanic that would 
have resulted in a successful voyage (i.e. avoiding the icebergs!!) 

 

Turn on cities.   

 

Click the Draw Line tool  . First, click on Cobh.  Keep single clicking to add vertices to 
your route until you reach New York.  Remember you can right click and hold the mouse 
so that you can select “zoom in” or “zoom out” while you are creating your own route.  
Complete the line by double clicking on New York City.   

 

If you double click before the line has ended, press the “delete” key on your keyboard 
and start over.  Your route should be comprised of only 1 line segment. 

 

If you find points on the line that need adjusting, click the Vertex Edit tool . The 
vertices are the points you added.  Click the line where it needs modification. Small 
boxes called vertices are visible.  
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Click a vertex and drag it to its correct point on the map. Continue this process until the 
entire line is in the correct place.   You can add a vertex if you missed a point by clicking 
on the line where no vertex exists.  Then you can adjust its location in the same way as 
above. 

 

When you are satisfied with your line, perform the following 2 steps: 

 

1)  Click on the pointer tool .  Click on your line.  Observe the total length of the line 
to the lower left of the view. 

 

11a.  What is the length of your new route?  ____________________ kilometers 

 

 

11b.  Is your route longer or shorter than what the Titanic would have followed to New 
York? 

 

11c.  Why did you select the route that you did? 

 

 

2)  Select “Stop Editing” from the Theme pull-down menu. When asked if you want to 
save your edits, click Yes. 

Click the Clear Selected Feature button . You can now see the blue line that 
represents the proposed route of the Titanic. 

 

Make your new proposed route the active theme (raised up). 

 

From the Theme menu, select Properties. In the dialogue box, name the theme Ice-Free 
Route.    

11d.  Given the speed (in kilometers per hour) you indicated in step 10i, how long would 
the voyage have lasted (in hours) if the Titanic had used your proposed Ice-Free 
Route?  Show your work. 
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11e.  Recall that the Titanic left Cobh (Queenstown) on April 11, 1912, at 1:30 pm.  
Would the Titanic have arrived in New York City using the new proposed Ice-Free 
Route?  Is this later or earlier? 

 

 

11f.  Suppose the Titanic had to be in New York City no later than April 17th at 5:30 pm.  
Calculate the hours of sailing time the ship had available to reach New York if it left from 
Cobh on April 11 at 1:30 pm. 

 

 

11g.  Using the average speed in kilometers per hour of the Titanic and the hours of 
sailing time allotted to arrive in New York City on time, how short did the sailing route 
need to be (in kilometers)?   Show your work. 

 

 

11h.  Now, your task is to plot the route of the Titanic trying to avoid as many icebergs 
as possible while still arriving in New York by the deadline. 

Using the Titanic Investigations—Part 2 View, from the View pull down menu, select 
New Theme.  

For Feature type, select Line.  Click OK. 

Now you will use the Draw Line tool to create your own route for the Titanic that would, 
in your opinion, have resulted in a successful voyage and arrived on time in New York 
City. 

Click the Draw Line tool  . First, click on Cobh.  Keep single clicking to add vertices to 
your route until you reach New York.  Remember you can right click and hold the mouse 
so that you can select “zoom in” or “zoom out” while you are creating your own route.  
Complete the line by double clicking on New York City.   

If you double click before the line has ended, press the “delete” key on your keyboard 
and start over.  Your route should be comprised of only 1 line segment. 

If you find points on the line that need adjusting, click the Vertex Edit tool . The 
vertices are the points you added.  Click the line where it needs modification. Small 
boxes called vertices are visible.  

Ask your teacher where you should save your new theme that will represent your 
proposed Titanic route given the deadline.  Navigate to the folder your teacher directed 
you to and name the new theme abcdeadlineroute.shp, where ABC are your initials.  
Click OK. 

The new theme is now added to your table of contents.  You may need to scroll up to 
see it.  It has a dotted line around the theme’s checkbox. This indicates that the theme is 
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in “Edit” mode and can be created and modified. Because ArcView randomly selects a 
color for a new theme, you need to change it.  

Change the name of the Theme in the Theme pulldown menu under Properties, from 
abcroute, to “Proposed Route” 

Double-click your new abcdeadlineroute (Proposed Route) theme to edit its Legend.  

 

Double-click the small rectangle to bring up the Symbol Window.  

 

Click the Color Palette button  . Click a blue color.  Click Apply and close the Legend 
Editor and the Color Palette window.   

Click a vertex and drag it to its correct point on the map. Continue this process until the 
entire line is in the correct place.   You can add a vertex if you missed a point by clicking 
on the line where no vertex exists.  Then you can adjust its location in the same way as 
above. 

Your route needs to require less time than your answer to question 11a.  In other words, 
your route needs to allow the ship to make its deadline. 

When you are satistifed with your line, answer the following: 

11i.   What is the length of the deadline route? ________________kilometers 

 

11j.  Multiply the number of kilometers by the average speed of the Titanic. Would the 
ship have arrived in time in New York City? 

 

 

Click the Clear Selected Feature button . You can now see the blue line that 
represents the deadline route of the Titanic.  If the ship would have arrived long after the 
deadline, select the line and delete it by pressing the “delete” key.  Draw a new line that 
represents your proposed deadline route.   

 

If you are satisfied with the time the Titanic would have arrived in New York City on the 
new deadline route then Select “Stop Editing” from the Theme pull-down menu. When 
asked if you want to save your edits, click Yes. 

 

Make your new deadline route the active theme (raised up). 
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From the Theme menu, select Properties. In the dialogue box, name the theme 
Deadline Route.     

Zoom to the active theme Deadline Route.  

11k.  Go to the View pulldown menu and select “Layout.”  Make a landscape layout.  
Include the following. 

1)  Your name and an appropriate title. 

Include your name and title by using the text tool to  

enter it on the layout  .   

2)  Your proposed route of the Titanic (Ice-Free Route) 

3)  The actual route of the Titanic (Titanic Route). 

4)  Your deadline route of the Titanic (Deadline Route). 

5) Ice extent. 

6)  Ice drift. 

7)  Countries. 

8)  Oceans 

Print the layout on a printer. 

Save your project . 

Next, you will change the scale of the analysis to conduct a geographic investigation of 
the warnings that the Titanic had during its voyage about icebergs. 

 

Step 12.   Warning The Titanic 

In this section, you will use GIS and data tables to understand what the crew on the ship 
knew about icebergs along their route, and you will speculate what they could have done 
differently. 

In your Titanic project, go to the Window pull down menu and select the View entitled 
“Rescue and Discovery.”   

This view shows the locations where you will examine ice warnings that other ships gave 
the Titanic. 

Make the “Warnings” theme active and visible if it is not already so.   This map gives the 
position of all the ice warnings that other ships reported while the Titanic was crossing 
the Atlantic Ocean. 
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12a.  Comment on the pattern of these warnings.  Are the warnings spread out or 
concentrated in one area? 

 

 

 

12b.  What is the latitude and longitude that you would consider to be “centered” inside 
these points of warning? 

 

12c.  From which ship did the warning farthest to the southwest come from? 

 

Open the table for the Warnings theme . 

Examine the table.  Each row in the table is a separate warning sent from other ships 
about the ice. 

12d.  How many warnings were sent from ships about the danger of ice? 

 

12e.  Describe the types of ice they were issuing warnings about. 

 

 

12f.  Which ship issued the most warnings? 

 

 

12g.  When was the earliest warning sent?  Give the date and time. 

 

 

12h.  When was the latest warning sent?  Give the date and time. 

 

 

Exit the table.  Clear any selections you made.    Go back to the Warnings view. 
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Next, you will change the appearance of the warnings map so that the points will reflect 
when they were transmitted and what ship transmitted them. 

To do this, you need to change the legend.  Double click on the theme name Warnings 
in the view’s table of contents.   The Legend Editor appears. 

Go to “Load” and find the file “warnings.avl”  The avl is an ArcView Legend. 

Use “Ship” for the Field dialog box and click OK.  Click “Apply” on the legend editor and 
then close the legend editor.  Notice how your legend changes.  You should see a 
different anchor symbol for each ship. 

12i.  How many different ships issued warnings to the Titanic?   (Note that these are only 
the most pertinent and latest ones; others were issued during its voyage as well). 

 

 

Label the points with the ship names:   Pull down the Theme menu and select Auto 
Label.  Use “Ship” for the label field and allow overlapping labels. 

 

Next, you will need to copy the route of the Titanic that you digitized earlier to the current 
view so that you will be able to examine the Titanic’s position based on the warnings. 

Go to the Window pull down menu and select the View entitled “Titanic Investigation—
Part 2.”   

Make the Titanic Route theme active (“raised up”).  This is your “abctitanic” theme. 

From the edit pull down menu, select Copy Theme. 

Go to the Window pull down menu and select the View entitled “Warnings.”   

From the edit pull down menu, select Paste.   

Your Titanic Route theme should appear.    

Resize and zoom this window as necessary to help you in your work. 

You might want to double click on your Titanic Route theme to change the symbol from 
an arrow symbol to some other sort of line, so that the arrow won’t confuse your 
understanding of the Titanic’s last position.  The arrow extends beyond the actual final 
position.  Double click on symbol and choose the appropriate line type and size and then 
click “Apply.”  Close the legend editor.   

12j.  Make an observation about the Titanic Route and the ice warnings.   

 

 

12k.  Which ship’s warning was closest to the Titanic’s final position? 
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12l.  In your opinion, did the Titanic receive sufficient warning about the ice? 

 

 

 

12m.  Does it appear that the Titanic heeded the warnings it received? 

 

 

12n.  Why?   Name two reasons that you suspect might have been the cause. 

 

 

 

 

Your final task in this warnings section will be to investigate the most puzzling warning of 
all.   

This warning was issued by the wireless operator, Cyril Furmstone Evans aboard the 
Californian at 1050pm on 14 April 1912, calling the Titanic: 

“Say, old man, we are stopped and surrounded by ice.” 

The position of the Californian was 42.10 north latitude and 50.16 west longitude.   

Enter that position as a point on your map: 

Pull down the SchoolTools menu: 
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In the dialog boxes that follow, type in the latitude and longitude values listed above for 
the Californian.  Be sure to use negative numbers for west longitude. 

 

  

In the dialog box, type in the latitude and longitude values where the Californian was 
located.  Be sure to use a negative number for west longitude. 

You will see a point appear at this site.  Zoom out if you need to in order to see it. 

12o.  Use the measure tool  to determine how far this position is from the Titanic’s 
last known position in 1912.   

 

 ____________________ kilometers. 
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12p.  What direction was the Californian from the Titanic? 

 

 

However, before the Californian was able to relay their position, Titanic wireless operator 
Jack Phillips angrily responded, 

“Shut up, shut up.  You’re jamming my signal.  I’m busy.  I’m working Cape Race.”  
[Cape Race was the land station used in navigation by ocean-going vessels]. 

The Californian wireless operator waited patiently and then finally gave up, turned off his 
equipment, and went to bed.   

Now that you have examined the spatial aspects of the ice warnings, you will investigate 
the collision itself. 

 

Save your project. 

 

Step 13.   Investigating the Collision 

In this section you will investigate the collision that the Titanic had with the iceberg.   

Read the following text to help you with this section. 

At 11:40 PM on 14 April 1912, lookouts Fred Fleet and Reginald Lee were ready to call it 
a night as their shift ended in 20 minutes.  They were in the “crows nest,” a platform 
above the main deck of the ship. 

 

Crow’s Nest

The sea had been flat calm and the air bitterly cold. The two lookouts were without 
binoculars as they had been misplaced in Southampton.  Fleet noticed something 
directly ahead of the ship and as it grew larger he realized what it was. It was an iceberg, 
which was nearly black and difficult to see from having flipped over earlier.  He 
immediately rang the bridge and reported "Iceberg right ahead" to Sixth Officer Moody 
who had answered the phone.  Murdoch quickly sprang into action; ordering the engines 
stopped, then reversed his decision and told Quartermaster Robert Hichens to turn the 
wheel "hard-a-starboard".   
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Ships in that era where turned by turning the wheel in the opposite direction they were 
intending to turn. Thus "hard-a-starboard" meant turning the wheel to starboard, or right, 
which would turn the ship sharply to port, or left.  

Murdoch closed all the watertight compartments in the bottom of the ship as Hichens 
turned the wheel as far to the right as it would go.  At the last moment the ship began to 
veer to the left. It seemed at first that they had made it.  However, a grinding sound 
indicated that they had not been so lucky. The ship took a glancing blow along the 
starboard bow. 

 

13a.  How long after the Titanic heard the warning about ice from the Californian, which 
you learned about in the last section, did the Titanic strike the iceberg? 

 

 

13b.  Given the account in the above text, draw a sketch map below (on paper).  The 
map should be an overhead view, showing: 

Cardinal directions (north, east, south, west); 

A map (overhead view) of the Titanic and its immediate surroundings. 

The iceberg it struck;  

The manner in which the Titanic turned from 11:40pm and during the few 
minutes that followed in 3 time sequences:  11:40pm, 11:41pm, and 11:42pm 
(times are approximate). 

 
Your sketch map. 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

Given the above account, suppose the ship had a 1-minute warning before it struck the 
iceberg.  The Titanic’s stopping distance at 20 knots was 777 meters; its turning radius 
at 20 knots was 1,173,5 meters: 
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777 m
1173.5  m 

 

 

 

 

 

 

If the ship was moving at 20 knots, you will need to multiply this figure of 20 by 1.85 to 
obtain the speed in kilometers per hour.   

13c.  How fast was the ship moving, in kilometers per hour?   

__________ kilometers per hour 

13d.  How many meters are in 1 kilometer? ________________ 

 

13e.  Therefore, how many meters per hour was the ship moving?  Show your work. 

 

 ________________ meters per hour 

 

You now have the data to compute the mechanics of the collision. 

 

13f.  How many minutes are in an hour? ___________ 

13g.  How many meters would the ship have traveled in 1 minute?  Show your work. 

  

 

Compare this distance to its stopping distance, given above. 

13h.  Which required more distance—for the Titanic to stop, or for the Titanic to turn? 

 

13i.  According to the account you read earlier, did the Titanic try to stop or turn? 
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13j.  If the Titanic had stopped instead of tried to turn, could the Titanic have stopped in 
time to have avoided a collision?  Why? 

 

 

13k.  Speculate as to whether the Titanic should have stopped or turned as soon as the 
lookouts spotted the iceberg. 

 

 

 

Recall that the binoculars had been left in Southampton.  If the lookouts had the 
binoculars, presumably they would have had more warning.  In the next section, you will 
analyze and speculate whether the ship could have stopped in time supposing it had a 
2-minute warning instead of a 1-minute warning. 

13k.  How many meters would the ship have traveled in 2 minutes?     

____________ meters 

Compare this number you just computed to the ship’s stopping distance.   

13l.  Could the Titanic have stopped in time if it had a 2-minute warning? 

 

 

 

Save your project . 

In the next section, you will analyze the sinking of the ship in more detail with the 
communications that were sent back and forth. 

 

Step 14.   Investigating the Sinking of the Titanic 

Examine the following table of the Wireless Distress Messages Sent and Received 
14-15 April 1912.   

The key is as follows: 

D.F.T. - Frankfurt | D.K.F. - Prinz Friedrich Wilhelm | M.B.C. - Baltic | 
M.G.N. - Virginian 
M.G.Y. - Titanic | M.K.C. - Olympic | M.K.L. - Asian | M.L.C. - Celtic 
M.L.Q. - Mount Temple | M.P.A. - Carpathia | S.B.A. - Birma  

 

http://www.greatships.net/frankfurt.html
http://www.greatships.net/montnairn.html
http://www.greatships.net/baltic.html
http://www.greatships.net/virginian.html
http://www.greatships.net/titanic.html
http://www.greatships.net/olympic.html
http://www.greatships.net/celtic2.html
http://www.greatships.net/mounttemple.html
http://www.greatships.net/carpathia.html
http://www.greatships.net/birma.html


Exploring the Titanic Lesson                                                                                                        Page 55 of 78 
 

New York 
Time. 

Titanic 
Time 
(Approx.) 

Communications 

 
10:25 p.m. 12:15 a.m. La Provence receives Titanic distress signals. 
 

10:25 p.m. 12:15 a.m. 
Mount Temple heard Titanic sending C.Q.D. Says 
require assistance. Gives position. Can not hear me. 
Advise my Captain his position 41.46 N. 50.24 W. 

 

10:25 p.m. 12:15 a.m. Cape Race hears Titanic giving position on C.Q.D. 41.44 
N., 50.24 W. 

 

10:28 p.m. 12:18 a.m. 
Ypiranga hears C.Q.D. from Titanic. Titanic gives C.Q.D. 
here. Position 41.44 N., 50.24 W. Require assistance 
(calls about 10 times). 

 

10:35 p.m. 12:25 a.m. 
C.Q.D. call received from Titanic by Carpathia. 
Titanic said "Come at once. We have struck a berg. It's a 
C.Q.D., Old Man. Position 41.46 N. 50.14 W." 

 

10:35 p.m. 12:25 a.m. Cape Race hears M.G.Y. (Titanic) give corrected position 
41.46 N., 50.14 W. Calling him, no answer. 

 

10:36 p.m. 
 

12:26 a.m. 
 

M.G.Y. (Titanic) says C.Q.D. Here corrected position 
41.46 N., 50.14 W. Require immediate assistance. We 
have collision with iceberg. Sinking. Can nothing hear for 
noise of steam. Sent about 15 to 20 times to Ypiranga.  

 

10:37 p.m. 12:27 a.m. Titanic sends following: "I require assistance 
immediately. Struck by iceberg in 41.46 N., 50.14 W." 

 

10:40 p.m. 12:30 a.m. Titanic gives his position to Frankfurt, and says, "Tell 
your Captain to come to our help. We are on the ice." 

 

10:40 p.m. 12:30 a.m. 
Caronia sent C.Q. message to M.B.C. (Baltic) and 
C.Q.D.: "M.G.Y. (Titanic) struck iceberg, require 
immediate assistance." 

 

10:40 p.m. 12:30 a.m. Mount Temple hears M.G.Y. (Titanic) still calling C.Q.D. 
Our Captain reverses ship. We are about 50 miles off. 

 

10:46 p.m. 
 

12:36 a.m. 
 

D.K.F. (Prinz Friedrich Wilhelm) calls M.G.Y. (Titanic) 
and gives position at 12 a.m. 39.47 N., 50.10 W. M.G.Y. 
(Titanic) says, "Are you coming to our ?" D.F.T. 
(Frankfurt) says, "What is the matter with u ?" M.G.Y. 

http://www.greatships.net/titanic.html
http://www.greatships.net/provence.html
http://www.greatships.net/titanic.html
http://www.greatships.net/mounttemple.html
http://www.greatships.net/titanic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/ypiranga.html
http://www.greatships.net/titanic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/carpathia.html
http://www.greatships.net/titanic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/ypiranga.html
http://www.greatships.net/titanic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/frankfurt.html
http://www.greatships.net/caronia.html
http://www.greatships.net/baltic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/mounttemple.html
http://www.greatships.net/titanic.html
http://www.greatships.net/montnairn.html
http://www.greatships.net/titanic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/frankfurt.html
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(Titanic) "We have collision with iceberg. Sinking. Please 
tell Captain to come." D.F.T. (Frankfurt) says, "O.K, will 
tell." 

 

10:48 p.m. 12:38 a.m. Mount Temple hears Frankfurt give M.G.Y. (Titanic) his 
position 39.47 N., 52.10 W.  

 
10:55 p.m. 12:45 a.m. Titanic calls Olympic S.O.S.  
 

11:00 p.m. 12:50 a.m. 
Titanic calls C.Q.D. and says, "I require immediate 
assistance. Position 41.46 N., 50.14 W." Received by 
"Celtic." 

 

11:03 p.m. 12:53 a.m. 
Caronia to M.B.C. (Baltic) and S.O.S., "M.G.Y. (Titanic) 
C.Q.D. in 41.46 N., 50.14 W. Wants immediate 
assistance." 

 

11:10 p.m. 1:00 a.m. 

M.G.Y. gives distress signal. D.D.C. replies. M.G.Y.'s 
position 41.46 N., 50.14 W. Assistance from D.D.C. not 
necessary as M.K.C. shortly afterwards answers distress 
call. 

 

11:10 p.m. 1:00 a.m. Titanic replies to Olympic and gives his position as 41.46 
N., 50.14 W., and says, "We have struck an iceberg." 

 

11:12 p.m. 
 

1:02 a.m. 
 

Titanic calls Asian and said, "Want immediate 
assistance." Asian answered at once and received 
Titanic's position as 41.46., 50.14 W., which he 
immediately takes to the bridge. Captain instructs 
operator to have Titanic's position repeated. 

 

11:12 p.m. 1:02 a.m. 
Virginian calls Titanic but gets no response. Cape Race 
tells Virginian to report to his Captain the Titanic has 
struck iceberg and requires immediate assistance. 

 

11:20 p.m. 1:10 a.m. 
Titanic to M.K.C. (Olympic), "We are in collision with 
berg. Sinking Head down. 41.46 N., 50.14 W. Come 
soon as possible." 

 

11:20 p.m. 1:10 a.m. Titanic to M. K. C. (Olympic), Captain says, "Get your 
boats ready. What is your position?" 

 

11:25 p.m. 1:15 a.m. Baltic to Caronia, "Please tell Titanic we are making 
towards her." 

 

http://www.greatships.net/titanic.html
http://www.greatships.net/frankfurt.html
http://www.greatships.net/mounttemple.html
http://www.greatships.net/frankfurt.html
http://www.greatships.net/titanic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/olympic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/caronia.html
http://www.greatships.net/baltic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/olympic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/virginian.html
http://www.greatships.net/titanic.html
http://www.greatships.net/virginian.html
http://www.greatships.net/titanic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/olympic.html
http://www.greatships.net/titanic.html
http://www.greatships.net/olympic.html
http://www.greatships.net/baltic.html
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11:30 p.m. 1:20 a.m. 
Virginian hears M.C.E. (Cape Race) inform M.G.Y. 
(Titanic) "that we are going to his assistance. Our 
position 170 miles N. of Titanic." 

 
11:35 p.m. 1:25 a.m. Caronia tells Titanic, Baltic coming to your assistance." 
 

11:35 p.m. 1:25 a.m. 

Olympic sends position to Titanic 4:24 a.m. G.M.T. 40.52 
N., 61.18 W. "Are you steering southerly to meet us?" 
Titanic replies, "We are putting the women off in the 
boats." 

 
11:35 p.m. 1:25 a.m. Titanic and Olympic work together. 
 

11:37 p.m. 1:27 a.m. M.G.Y. (Titanic) says, "We are putting the women off in 
the boats." 

 

11:40 p.m. 1:30 a.m. Titanic tells Olympic, "We are putting passengers off in 
small boats." 

 

11:45 p.m. 1:35 a.m. Olympic asks Titanic what weather he had. Titanic 
replies, "Clear and calm." 

 
11:45 p.m. 1:35 a.m. Baltic hears Titanic say "Engine room getting flooded." 
 

11:45 p.m. 1:35 a.m. Mount Temple hears D.F.T. (Frankfurt) ask "are there 
any boats around you already?" No reply. 

 
11:47 p.m. 1:37 a.m. Baltic tells Titanic, "We are rushing to you." 
 

11:50 p.m. 1:40 a.m. Olympic to Titanic, "Am lighting up all possible boilers as 
fast as can." 

 

11:50 p.m. 
 
 
 

1:40 a.m. 
 
 
 

Cape Race says to Virginian: "Please tell your Captain 
this: "The Olympic is making all speed for Titanic but his 
(Olympic's) position is 40.32 N., 61.18 W. You are much 
nearer Titanic. The Titanic is already putting women off 
in the boats, and he says the weather there is calm and 
clear. The Olympic is the only ship we have heard say, 
"Going to the assistance of the Titanic. The others must 
be a long way from the Titanic." 

 

11:55 p.m. 1:45 a.m. Last signals heard from Titanic by Carpathia, "Engine-
room full up to boilers." 

 

11:55 p.m. 1:45 a.m. Mount Temple hears D.F.T. (Frankfurt) calling M.G.Y. 
(Titanic). No reply.
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(Titanic). No reply. 
 

11:57 p.m. 1:47 a.m. Caronia hears M.G.Y. (Titanic) though signals 
unreadable still. 

 

11:58 p.m. 1:48 a.m. Asian heard Titanic call S.O.S. Asian answers Titanic but 
receives no answer. 

 

Midnight 1:50 a.m. 
Caronia hears Frankfurt working to Titanic. Frankfurt 
according to position 172 miles from M.G.Y. (Titanic) at 
time first S.O.S. sent out. 

 

12:05 a.m. 1:55 a.m. Cape Race says to Virginian "we have not heard Titanic 
for about half an hour. His power may be gone." 

 

12:10 a.m. 2:00 a.m. Virginian hears Titanic calling very faintly, his power 
being greatly reduced. 

 

12:20 a.m. 2:10 a.m. Virginian hears 2 v's signalled faintly in spark similar to 
Titanic's probably adjusting spark. 

 

12:27 a.m. 
 

2:17 a.m. 
 

Virginian hears Titanic call C.Q., but unable to read him. 
Titanic's signals end very abruptly as power suddenly 
switched off. His spark rather blurred or ragged. Called 
M.G.Y. (Titanic) and suggested he should try emergency 
set, but heard no response. 

 

12:30 a.m. 2:20 a.m. 

Olympic, his sigs. strong, asked him if he had heard 
anything about M.G.Y. (Titanic) He says, "No. Keeping 
strict watch, but hear nothing more from M.G.Y. (Titanic). 
No reply from him. 

 

12:52 a.m.  
This was the official time the Titanic foundered in 41.46 
N., 50.14 W. as given by the Carpathia in message to the 
Olympic; about 2:20 a.m. 

 

1:15 a.m.  
Virginian exchanges signals Baltic. He tries send us 
M.S.G. for M.G.Y. (Titanic), but his signals died utterly 
away. 

 

1:25 a.m.  Mount Temple hears M.P.A. (Carpathia) send, "If you are 
there we are firing rockets." 

 
1:35 a.m.  Baltic sent 1 M.S.G. to Virginian for Titanic. 
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1:40 a.m.  M.P.A. (Carpathia) calling M.G.Y. (Titanic). 
 

1:58 a.m.  
S.B.A. (Birma) thinks he hears Titanic so sends, 
"Steamship full speed for you. Shall arrive you 6-0 in 
morning. Hope you are safe. We are only 50 miles now."

 
2:00 a.m.  M.P.A. (Carpathia) calling M.G.Y. (Titanic). 
 

2:00 a.m.  Have not heard Titanic since 11.50 p.m. Received from 
Ypiranga. 

 

2:28 a.m.  La Provence to Celtic, "Nobody has heard the Titanic for 
about 2 hours." 

 
3:24 a.m.  S.B.A. (Birma) says we are 30 miles S.W. off Titanic. 
 

3:35 a.m. 
  

Celtic sends message to Caronia for the Titanic. Caronia 
after trying for two hours to get through to the Titanic tells 
the Celtic impossible to clear his message to Titanic. 
Celtic then cancels message. 

 

3:45 a.m.  "Californian" exchanges signals with M.L.Q. (Mount 
Temple). He gave position of Titanic. 

 
4:10 a.m.  "Californian" receives M.S.G. from M.G.N (Virginian). 
 
5:05 a.m.  Baltic signals M.P.A. (Carpathia). 
 

5:40 a.m.  
Parisian hears weak signals from M.P.A. (Carpathia) or 
some station saying Titanic struck iceberg. Carpathia has 
passengers from lifeboats. 

 

5:40 a.m. 
  

Olympic Tr Asian, with German oil tank in tow for Halifax 
asked what news of M.G.Y. (Titanic). Sends service later 
saying heard M.G.Y. (Titanic) v. faint wkg. C. Race up to 
10.0 p.m., local time. Finished calling S.O.S. midnight. 

 

6:05 a.m. 
  

Parisian exchanges TRs Virginian O.K. nil. Informed 
Captain Haines what I heard passing between ships 
regard steaming Titanic, and he decided not to return as 
M.P.A. (Carpathia) was there, and  
"Californian" was 50 miles astern of us but requested me 
to stand by in case required. 

 

6:45 a.m.  Mount Temple hears M.P.A. (Carpathia) report rescued 
20 boat loads.
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20 boat loads. 
 

7:07 a.m.  

Baltic sends following to Carpathia: "Can I be of any 
assistance to you as regards taking some of the 
passengers from you ? Will be in position about 4:30. Let 
me know if you alter your position." 

 

7:10 a.m.  
Baltic in communication with M.P.A. (Carpathia). 
Exchanged traffic re passengers, and get instructions to 
proceed to Liverpool. 

 

7:15 a.m.  Baltic turns round for Liverpool, having steamed 134 
miles W. towards Titanic. 

 

7:40 a.m.   

Mount Temple hears M.P.A. (Carpathia) call C.Q. and 
says no need to std. bi him. Advise my Captain, who has 
been cruising round the icefield with no result. Ship 
reversed. 

 

7:45 a.m.   
Olympic sent M.S.G. to Owners, New York via Sable 
Island, saying, "Have not communicated with Titanic 
since midnight." 

 

7:55 a.m.  
Carpathia replies to Baltic, "Am proceeding to Halifax or 
New York full speed. You had better proceed to 
Liverpool. Have about 800 passengers on board."  

 

8:00 a.m.  
Carpathia to Virginian. "We are leaving here with all on 
board about 800 passengers. Please return to your 
Northern course." 

 
 

14a.  This disaster was the first time an SOS was sent in Maritime history.  What other 
type of distress signal was sent from the Titanic? 

 

14b.  How many total ships could hear the Titanic’s distress calls?  Note:  Cape Race is 
a signal station on land—it is not a ship. 
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14c.  Based on the data above and in the paragraph you read about the striking of the 
iceberg, how long did the Titanic float after the collision? 

 

 

14d.  Which ship eventually picked up survivors of the Titanic? 

 

Read the following and answer the questions. 

 

Screams and cries filled the air, as 1,500 
passengers floated in the water. As the cries 
continued, the survivors sat in lifeboats. Only a few 
wanted to go back for more people. Most of them 
thought the lifeboats would get "swamped" if they 
went back. After time, the cries died down and there 
came a deadly silence. At 3:30 am, rockets were 
sighted from the Carpathia (image at left). 

 

The first lifeboat was picked up at 4:10 AM and the last one at 8:30 AM. At 8:50, the 
Carpathia heads for New York.  She arrived at New York on 18 April 1912 at 9:00 pm.  

 

14e.  How long after the Titanic sank did the Carpathia pick up its first passengers in 
lifeboats? 

 

Titanic’s lifeboats, photo taken from the Carpathia. 
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14f.  Why do you think the passengers could not float and survive long enough for them 
to be rescued?  Consider what you know about the geographic location. 

 

 

Was there a ship closer than the Carpathia?  Yes, it seems that two ships were nearer.  
One was the Californian.  On board the Californian, Second Officer Stone had observed 
white rockets bursting over a strange ship to the south.  Attempts were made to contact 
it by Morse lamp but these were in vain. Eventually Captain Stanley Lord was awakened 
and notified.  He went down to the chart room but asked to informed only if the ship 
appeared to move closer. Stone and Apprentice Gibson continued to watch as more 
rockets were fired over this strange ship. At 2 am the ship appeared to be sailing away 
to the southwest and 20 minutes later disappeared completely.  

As Titanic was taking on water, the last of the lifeboats was lowered. Those still on the 
ship could see the mast light of a nearby ship. Officer Boxall on the Titanic lit flares to 
signal it, and those on the ship thought they were saved. But instead of coming to the 
rescue, the light went further away until it was out of sight.  At that moment 1500 
people’s hopes vanished and they knew they were doomed.  

What was this mysterious ship, and why didn’t it come to Titanic’s rescue? One answer 
to this is that this ship was in fact the Californian. The Californian was in the vicinity of 
Titanic. Just before Titanic hit the iceberg, the Californian had given the Titanic an ice 
warning, to which Titanic's radio operators told him to shut up.  

On board Californian when Titanic was going down, a crew member could see the 
Titanic, but thought the bow lights were turned off. As it turned out they were under 
water.  

He also saw the emergency flares, but dismissed them it as a shooting star. Whatever 
happened on the Californian, it never reached Titanic. When the next morning it was 
informed of the disaster by the Carpathia, it raced to the scene of the disaster looking for 
survivors, but it was too late.  

From the Titanic, the light in the distance looked to be about 6 miles away. The Captain 
of the Californian claimed he was over 18 miles away. Was there another ship nearby?  
In the 1960's, a man came forward saying that he had been a crewman of a sealer, the 
Sampson. He said that it was illegally sealing on the night of 14 April 1912.  Those on 
the Sampson saw the distress flares from Titanic, but thought they were a warning from 
the coastguard, and they immediately exited the area.  

14g.  Do you think the Californian and the “mystery ship” were one and the same, or two 
different ships?  Why? 

 

 

 

 

 

http://www.webtitanic.net/framecal.html
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14h.  Speculate as to whether you think all the passengers and crew could have been 
saved had the Californian or the “mystery ship” come to the rescue of the Titanic. 

 

 

You will now use GIS to examine these rescue ships.   

First, you will need to copy the Titanic route that you digitized earlier to a different view if 
you haven’t already done so. 

Go to the Window pull down menu and select the View entitled “Titanic Investigation—
Part 2.”   

Make the Titanic Route theme active (“raised up”). 

From the edit pull down menu, select Copy Theme. 

Go to the Window pull down menu and select the View entitled “Rescue and Discovery.”   

This view shows the location of the other ships in the area.  From the edit pull down 
menu, select Paste.  Your Titanic Route theme should appear.   Resize this window as 
necessary to help you in your work. 

If you would like to change the text color of the ships, select the text with the pointer tool 
, go to “Window” pulldown menu, and Show Symbol Window.  Go to the paintbrush, 

select text, and select a new color. 

The next steps involve calculating distances.   

Find the graphics pull down tool (a dot) and pull it down.   

 

Select the circle tool.  Click on the end point of the route of the Titanic (where it sank) 
and expand the tool until it intersects the mystery ship (hold down the mouse key to 
expand the circle).  Note the radius of the circle to the lower left of the view window.  
Your screen should look similar to the one below: 
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14i.  What was the distance from the Titanic to the “mystery ship?” 

 

Expand the circle tool further to answer the following questions.  With the pointer tool, 
make the circle active by clicking on it.  Expand the circle by grabbing one of the black 
corners surrounding the circle with the pointer and hold the mouse key down. 

14j.  What was the distance from the Titanic to the Californian? 

 

14k.  What was the distance from the Titanic to the Carpathia? 

 

14l.  What direction from the Titanic was the Carpathia? 

 

Pack ice is packed together by wind and water currents into one continuous sheet.  Field 
ice is frozen sea water floating more loosely than pack ice.  An ice floe is a patch of sea 
ice.  This is dangerous but sometimes navigable.  The actual iceberg that the Titanic 
struck was described by witnesses as 200 to 400 feet long with a high peak of 100 feet.  
The photographs earlier in this lesson may be those of the actual iceberg struck by the 
ship.  Turn on the ice flow theme. 

14m.  Use the measure tool  to determine the maximum north-south extent of the ice 
floe: 

 ______________  kilometers 

14n.  Which other ship besides the Titanic was at the edge of the ice floe? 
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Turn on the theme  “Lifeboats”.  This indicates the point where the Carpathia picked up 
the lifeboats.   

14o.  What direction from the last known position of the Titanic were the lifeboats picked 
up? 

 

14p.  Explain why the lifeboats were picked up in this direction from the Titanic. 

 

 

 

14q.  How far from the last known position of the Titanic were the lifeboats picked up? 

 

 ___________ kilometers 

14r.  Give at least two possible reasons why the lifeboats were not picked up at the 
exact location of the last known position of the Titanic. 

 

 

 

 

Save your project . 

You are now ready to investigate what happened to the people on the Titanic. 

 

Step 15.  Studying the Saved and the Lost. 

15a.  Based on what you have learned so far, why couldn’t everyone be saved on the 
Titanic? 

 

 

Consider the following summary of the numbers of Passengers and Crew on Titanic and 
answer the questions that follow.  People booked passages on ocean liners in “first 
class” through “third class” cabins, or rooms.  Each class had certain amenities; first 
class having the most luxurious accommodations.  Classes on many ships even had 
their own, separate, dining rooms. 
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Passenger and Crew Populations 

Type of People On Board 
(Approximate) 

Number 
 

First Class 330 
Second Class 320 
Third Class 750 
  
Total Passengers 1400 
  
Officers and Crew 940 
Total Passengers and Crew 2340 
  
Passengers Saved 535 
  
First Class  210 
Second Class 125 
Third Class 200 
  
Crew Saved 210 
  
Officers 4 
Seamen 39 
Stewards 96 
Firemen 71 

  
 
15b.  What percentage of people were saved?  Show your work. 
 
 
 
 
15c.  What were your chances of survival if you were a first-class passenger?  Give the 
appropriate percentage and show your work. 
 
 
 
15d.  What were your chances of survival if you were a third-class passenger?  Give the 
appropriate percentage and show your work. 
 
 
 
15e.  What were your chances of survival if you were any sort of passenger?  Give the 
appropriate percentage and show your work. 
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15f.  What were your chances of survival if you were any sort of crew member?  Give the 
appropriate percentage and show your work. 
 
 
 
15g.  What type of either passenger or crew member would you choose to be if you 
wanted the best chance of survival? 
 
 
 
 
15h.  Based on your reading above, what class would most immigrants, moving to North 
America, been in?  Circle your answer. 
 
 
 First Class  Second Class  Third Class 
 
 
15i.  Why? 
 
 
 
 
 
15j.  Therefore, were a higher or lower proportion of immigrants lost in the disaster than 
wealthy people?  Circle your answer. 
 
 Higher   Lower 
 
 
 
 
 
 
The Titanic was built to hold 2,435 total passengers.   
 
15k.  How full was the Titanic on its maiden voyage?  Give a percentage and show your 
work. 
 
 
 
15l.  What would have happened to the chances of survival for any given person if the 
ship had been full?  Circle your answer. 
 

They would have increased  They would have decreased 

 

15m.  Why? 
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Save your project . 

Perhaps the only good thing that came from the Titanic disaster is that it had a far-
reaching affect on shipping routes.  You will examine that in the next step. 

 

Step 16.  Examining Shipping Routes Before and After the Titanic Disaster 

 

Use the Window pull down menu and select the View “Titanic Investigation-Part 2.” 

Turn on the theme “Routes.”  Make it visible and active. 

The only other themes you should have visible are:  oceans, countries, iceberg extent, 
and the route of the Titanic. 

Zoom to the extent of the Routes theme to see the North Atlantic Ocean routes for 
shipping . 

As you examined earlier in this lesson, ships took the “Great Circle” routes, or the 
shortest distance between any two points on a globe, across the oceans. 

Ships from Cobh sailing west took a similar route to Fastnet Light, an important 
navigation aid, at approximately 51.40 north latitude and 9.59 degrees west longitude.   

Zoom in on this point.   

 

16a.  What country is Fastnet Light off the coast of? 

 

On the other side of the Atlantic Ocean, zoom in on the point at 40.23 north latitude and 
69.55 west longitude .   

16b.  What do you notice about the route of ships to the west of this point versus east of 
this point? 

 

 

 

This point was the location of Nantucket Lightship, another important navigation aid. 

 

Use the identify button   and click on each route.  Routes theme needs to be 
active,”raised up”.   

 



Exploring the Titanic Lesson                                                                                                        Page 69 of 78 
 

Notice that the westbound and the eastbound routes have two components: 

1)  A “winter-spring-summer” route that lasts usually from January through August. 

2)  An “autumn” route that usually lasts from August or September through January. 

 

16c.  Both before 1913 and also after 1913, which route is further south for westbound 
ships—the Winter-Spring-Summer route or the Autumn route?   

 

 

16d.  Why? 

 

Use the measure tool  to answer the following question: 

16e.  For eastbound or westbound ships, how far south is the autumn route from the 
winter-spring-summer route? 

 

 

16f.  Examine your plotted route of the Titanic (Titanic Route, the abctitanic).  Did the 
Titanic follow an established route? 

 

 

16g.  Which route did the Titanic follow? 

 

 

16h.  Did the Titanic follow a winter-spring-summer route, or an autumn route?    

 

 

16i.  Why did it follow this season’s route? 

 

 

In the Atlantic, there was one important variation to the Great Circle route, due to the 
known ice hazard near the Grand Banks.  Westbound ships took the Great Circle Route 
from Fastnet Light to a point south of Newfoundland known as the Turning Point, or 
Corner.  Eastbound ships took a route from Nantucket Lightship to the Corner. 
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The corner was the point where the ship turned slightly in its route.  For westbound 
ships, they turned from sailing southwesterly to more due west.  For eastbound ships, 
they turned from sailing mostly east to a more northeasterly direction. 

16j.  Find the longitude of most of the corners along the route.  What is the longitude? 

 

 

16k.  Find the latitude and longitude of the Titanic’s “corner.”  What are they? 

 

 

Heavy spring ice in 1902 and 1903 caused the westbound corner to be moved one 
degree south, to 41 degrees north latitude. 

16l.  How far south, in kilometers, would the corner have been after 1903 versus before 
1903? 

 

 

By the year the Titanic sailed, the corner had been moved back to 42 degrees north. 

 

16m.  Speculate as to what difference it would have made to the Titanic if the corner had 
been left at 41 degrees north. 

 

16n.  Did the Titanic turn the corner before it struck the iceberg? 

 

 

Ironically, Captain Smith reached the corner at 5pm on 14 April, but continued on the 
same course until 5:45pm, which took the ship nearly 26 kilometers southwest, to about 
18 kilometers south of the normal route.  He probably did this because of the ice 
warnings the ship had been receiving.   

Notice the two colors that identify the routes as “Before 1913” and “After 1913.”  The 
Titanic disaster caused 13 nations to convene the International Convention for the 
Safety of Life at Sea (SOLAS) in 1913.  The resulting treaty fixed new turning points.  
This convention also created the International Ice Patrol, required lifeboats for all 
passengers, boat drills, and a 24-hour radar watch.  Modern shipping is regulated by the 
International Maritime Organization, and by 1997, 136 countries had ratified SOLAS.   
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16o.  What direction did all the shipping routes move after 1913 from their old pre-1913 
routes? 

 

 

16p.  Why do you suppose they moved in this direction? 

 

 

16q.  Based on the above paragraph, would you say that the Titanic disaster changed 
things for the better for ocean-going ships and their passengers?  Why? 

 

 

Save your project .  In the next step, you will examine the discovery of the Titanic’s 
wreck from a spatial perspective. 

 

Step 17.  Discovering the Titanic’s Wreck 

In this section, you will explore the search and discovery of the wreck of the Titanic, 
emphasizing the geographic perspective. 

Pull down the “Window” menu, and select the View entitled “Rescue and Discovery.” 

The discovery of the wreck of the Titanic was something the world had long been waiting 
for.  However, it had to wait for the following developments in deep-sea exploration to 
occur: 

1930 - first bathysphere, dove to 922 meters 

1948 - first bathyscaphe, eventually descended to 3962 meters 

1960 - Descent to 10912 meters in Mariana Trench in bathyscaphe 

1964 - Manned submersible, Alvin 

1973 - Alvin descends to 3962 feet 

1976 - Angus (visual imaging vehicle) and ARGO (video and sonar submersible) 
 developed 
 

1980 - Texas oilman Jack Grimm hired 38 member Titanic search team, makes 4  
expeditions through 1983, spending $2 million. 
 

1984 - Robert Ballard’s Deep Submergence Laboratory group at Woods Hole  
Oceanographic Institute develop self-propelled robot called JASON, 
tethered to their submersible ARGO. 
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 1985 - Ballard and French Sonar team locate Titanic on 1 September 1985 at  
1:05AM.  The bow and stern of Titanic were lying 1970 feet apart at 41.73 
degrees north latitude, 49.93 degrees west longitude.  The wreck is at 
3798 meters below the surface (12,460 feet), which is 10 times deeper 
than the Empire State Building is high. 

 
Turn on the theme “Grimm Search Area.”  This is the area that Grimm’s team searched 
in 1980 through 1983. 
 

Find the graphics pull down tool (a dot) and pull it down.   

 

Select the polygon tool.  Use the tool to trace the perimeter of Grimm’s search area.  
Double click when you’ve completed the polygon.   

17a.  How large was the search area? 
 
 
 
 
 
17b.  How many years had elapsed between the Titanic’s sinking and its discovery on 
the bottom of the ocean? 
 
 

 

From the Window menu, select Show Symbol Window. Select the Marker Palette . 
Change the size to 8 and the color to red. 

Pull down the SchoolTools menu: 
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In the dialog boxes that follow, type in the latitude and longitude values that you wrote 
above for Cobh.  Be sure to use negative numbers for west longitude. 

 

 

In the dialog box, type in the latitude and longitude values where the wreck was found.  
Be sure to use a negative number for west longitude. (41.73, -49.93) 

You will see a point appear at the wreck site. 

17c.  Use the measure tool to determine how far the wreck is from the Titanic’s last 
known position in 1912. 

 _________________ kilometers. 

17d.  What direction is the wreck from the last known position of the Titanic? 
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17e.  Give two possible reasons why the wreck was not found exactly at the Titanic’s last 
stated known position in 1912. 

 

 

 

17f.  Was the discovery site inside Grimm’s 1983 search area? 
 
 
Because of a strong current, Grimm’s crew missed the canyon where the Titanic lies. 
 
 

Next, you will create your own map of the site of the wreck. 

Make the “Wreck Site” theme visible.  Zoom to the extent of this theme:   

You are now examining the wreck site.  The Titanic broke apart while sinking, as 
affirmed by eyewitnesses at the time.  These observations were largely scoffed at by the 
“learned”, but were confirmed many decades later when the wreck was discovered in 2 
main pieces.   

 

A photograph of the bow of the Titanic as it lies at the bottom of the ocean. 

Sonar mapping revealed only 12 finger-sized slits in the hull, a total of only 2 meters 
long.  A hole the height of a human had sunk the unsinkable ship. 

 

The stern (back part) was found at 41.7264 north latitude and 49.9415 west longitude. 

The bow (front part) was found at 41.7325 north latitude and 49.9469 west longitude. 

A debris field was found at 41.7255 north latitude and 49.9469 west longitude. 
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Plot these three locations by the following procedures that you have used elsewhere in 
this lesson: 

Pull down the SchoolTools menu: 

 

 

In the dialog boxes that follow, type in the latitude and longitude values that you wrote 
above for Cobh.  Be sure to use negative numbers for west longitude. 

 

 

In the dialog box, type in the latitude and longitude values where the three main sites of 
the wreck was found.  Be sure to use a negative number for west longitude. 

You will see a point appear at the wreck site.   Zoom in   

 



Exploring the Titanic Lesson                                                                                                        Page 76 of 78 
 

Label it with the Text label tool  as  “Stern.”   

Use the second tool underneath “T”, click on the point, and then, holding the mouse, 
move the mouse away so the text “leaders in” to the point.   

This is seen in the following example: 

Repeat these procedures for the bow and the debris field, and label them accordingly. 

 

 

17g.  Examine your map.  What direction is the bow from the stern? 

 

17h.  Use the measure tool  to determine how far the bow is from the stern.  Write 
your answer below: 

 

_______________ kilometers, or  _________________ meters 

 

Next, create your own theme of the wreck site so that these locations are permanently in 
a file that you can go back and examine in the future.  Use the following procedures. 
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Use the View pulldown menu and select “New Theme.”  Make your new theme a Point 
theme.  Name it wreck_pieces.shp. 

Find the graphics pull down tool (a dot) and pull it down.   

 

Select the dot and digitize three points, on top of the ones you have there already:  The 
stern, the bow, and the debris field. 

Open the theme table for the new theme you are creating . 

Select the “Edit” pulldown menu and select “Add Field.” 

Name the new field “Name” and make it a String field that is 20 characters wide. 

Select the edit button  and enter your text in each of the rows under the new  “Name” 
Field, as appropriate:   

stern,  

bow,  

debris field.   

Be sure to click your mouse OFF of debris field before going to the following step, to 
make sure it gets saved. 

Select the Table pulldown menu and then, “Stop Editing.”   

Select YES to saving your edits.   

Go back to the Rescue and Discovery View. 

Go to the Theme pulldown menu and select Stop Editing. 

Save your edits. 

 

Label your features as you did earlier with the Leader Text symbol. 

Go to the Theme pulldown menu and rename your theme  Wreck Pieces. 
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Next, plot your map using the following procedures. 

First, zoom out so you can see the stern, bow, and debris field.   

Go to the View pull  down menu and select “Layout.”   

Make a landscape layout of your route.   

Include your name by using the text tool to enter it on the layout  .   

Title the layout “Rescue and Discovery.”    

 

17i.  Print the layout on a printer. 

Save your project .   From the File menu, click Exit.   

When it asks if you want to save your changes, click No. 

 

17j.  Write an essay on the Titanic disaster from a spatial, or geographic, perspective, 
including a consideration of the following items.  Include your impressions on whether 
maps and the geographic perspective helped you understand the Titanic.  Illustrate your 
essay with maps from your GIS-based investigation.  For the essay, consider everything 
that you have learned about the Titanic, including: 

 Reasons for Construction  
Route 

 Ocean Currents 
 Icebergs 
 Warnings 
 Persons Saved and Lost 

Rescue 
Discovery 
Changes After the Titanic Disaster To Shipping on the North Atlantic 

 
 
*** End of Titanic Lesson *** 


